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The PROTEM2 is an integrated software for the management of parameters and measured values, consisting of the following tools.  

This software consists of the following tools. 

 

PROTEM2 Base tool --------------------------- Used to set and verify the parameters. 

Recipe tool --------------- Used to save the parameters to a computer and transfer the data to the instruments. 

Logging tool ------------- Used to visualize the various data and log the data in a CSV format. 

Report tool --------------- Used to create a list (report) of parameters and save the data in CSV/HTML format. 

Backup tool -------------- Used to make overall management of set values (saving to a computer, transferring to a controller, verifying 

the data). 

Setting tool for the PZ series --------------- Used to set and check the parameter setting of the PZ series. 

Setting tool for the PF900 series ---------- Used to set and check the parameter setting of the PF900 series. 
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 Modbus is a registered trademark of Schneider Electric. 

 Other company names and product names mentioned in this manual are (or may be) trademarks or registered 
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: This symbol is used for important items for operation and handling of the product. 
 

: This symbol indicates supplemental information on installation, handling and operating 
procedures. 

 
: This symbol is used to show the reference where details and relating information are 

obtained. 
 

 In this document a personal computer is referred to as a computer or a PC. 

 In this document menus and dialog boxes are shown with quotation marks (“ ”), whereas buttons and 
tabs are shown with [brackets]. 

 
 

 This Software tool enables a user to monitor and set all the set values including those in the initial 

setting level. This may cause an unexpected change of the specification. RKC is not responsible for 

any damage of the products and the equipment due to the use of this software. 

 RKC is not responsible for any damage of any kind, including computer virus and unauthorized entry 

to the computer and computer networks. 

 This manual assumes that the reader has a fundamental knowledge of the principles of electricity, 

process control, computer technology and communications. It is assumed that the reader has a 

fundamental knowledge of the Windows such as terminology and operation. For detailed terminology 

and operation, refer to the manuals of the operating system and the PC you use. 

 The figures, diagrams and numeric values used in this manual are only for purpose of illustration. 

 RKC is not responsible for any damages and/or injury listed below. 

 Damages due to the use of this product. 

 Damages due to unexpected failures in this product. 

 Damages due to the use of counterfeits of this product. 

 All other indirect damages. 

 Unauthorized duplication or modification of the software for purposes other than backup is prohibited. 

 The information in this manual is subject to change without prior notice. 

 No portion of this document may be reprinted, modified, copied, transmitted, digitized, stored, processed 

or retrieved through any mechanical, electronic, optical or other means without prior written approval 

from RKC. 

Notice Before Use 

Notation in This Manual 

TIPS 

NOTE 

Note 
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■ Operating Environment 
To run this Software, we recommend using a PC with the specifications detailed below.  

Operating system Windows 10 (64-bit edition)  
[PROTEM2 works only on Windows 10 (64-bit edition) and has not been tested on other versions of Microsoft Windows.] 

Firmware .NET Framework 4.5 or later 

Memory (RAM) 100MB or more (free memory space) 

Hard disk 100MB or more (free disk space) 

Display 1024×768 or higher 

Others Serial communication port or USB2.0 port 

 

■ Models Supported by PROTEM2 
PROTEM2 supports the following models. 

 
 

Modular Controllers  
SRZ System 

Extended Communication Modules 
Z-COM-A 

 Digital Controllers 
HA series  *1 

HA400, HA900 

Temperature Control Modules 
Z-TIO-A/B/C/D 

 Digital Melt Pressure Controllers 
HA series  *1 

HA430, HA930 

Temperature Control Module with 
High Resolution 
Z-TIO-G 

 Digital Indicators 
 

AG500 

Digital Input/Output Module  
Z-DIO-A 

 Wireless Temperature Sensor 
Converters 
NWS series  *1 

NWS-COM 
NWS-COM-M1 

CT Input Module 
Z-CT-A 

 High Performance Power  
Controllers 

THV-A1 

Modular Controllers  
SR Mini HG System 
SR Mini System 

H-……: SR Mini HG System 
M-……: SR Mini System 

Power/CPU Modules 
H-PCP-A/B/J 
M-PCP-A/B 

 Open Board Temperature 
Controllers 
 

B400 

Temperature Control Modules 
H-TIO-A/B/C/D/E/F/G/H/J 
M-TIO-A/B/C/D 

 Digital Controllers 
RB series  *2 

RB100, RB400, RB500, RB700, 
RB900 

Temperature Input Modules 
H-TI-A/B/C/D 
 

 Digital Controllers 
RD series 

RD100, RD400, RD500, RD700, 
RD900 

CT Input Modules 
H-CT-A 
M-CT-A 

 Digital Controllers 
RZ series  *2 

RZ100, RZ400 

Analog Input Modules 
H-AI-A/B 
M-AI-A/B 

 Digital Controllers 
SA series  *1 

SA100, SA200 

Analog Output Modules 
H-AO-A/B 

 Temperature Controller with  
a built-in SSR 
 

SB1 

Digital Input Modules 
H-DI-A/B 
M-DI-A 

 Melt Pressure Indicator 
 

PG500 

Digital Output Modules 
H-DO-A/B/C/D/E/G 
M-DO-A/B 

 Intelligent Control Output Distributor 
*1 

IOPD 

Cascade Control Modules 
H-CIO-A 

 Power Controllers 
 

THV-40/THV-10 (150/200A) 
THV-10 (20A to 100A) 

Speed Control Module 
H-SIO-A 

 Ramp/Soak Program Controllers 
*3 

PZ400, PZ900 
PF900, PF901 

Modular Controllers 
SRJ  *1 

J-TI  USB Communication Converters 
*1 

COM-KG (NWS wireless)  
 

Digital Controllers 
FB series 

FB100、FB400、FB900  Communication Converters 
COM-ME series 

 

Digital Controllers 
FZ series 

FZ110、FZ400、FZ900  Communication Converters 
COM-ML series 

 

Digital Controllers 
GZ series 

GZ400, GZ900    

 
*1 Supported by PROTEM2 Japanese edition only. 
*2 Supported by PROTEM2 Japanese and English editions only. 
*3 Use Setting tool for the PZ series or the PF900 series which are supported by PROTEM2 (English edition). Base tool (English edition) does 

not cover this model. 

For the latest information, please check our website. 

1. Before Using This Software 
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■ Procedure to Set up PROTEM2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 

 
 
 

 
 

Models supported by 
PROTEM2 

 
 
 

Installing PROTEM2 
 
 
 

Connecting an instrument 
and a PC 

 
 
 

Starting/Ending PROTEM2 
 

Before using PROTEM2, make sure your model is included in 
the models supported by PROTEM2. 

Refer to P. 1-1 

Install PROTEM2 to your computer after downloading it from 
our website. 

Refer to P. 2-1 

Refer to P. 3-1 

Refer to P. 4-1 Check Starting/Ending PROTEM2. 

Arrange for necessary items such as a converter and finish 
wiring. 

Refer to P. 8-1 This part describes how to run a ramp/soak program on  
the PZ series using the Setting tool for the PZ series. 

Refer to P. 9-1 This part describes how to run a ramp/soak program on  
the PF900 series using the Setting tool for the PF900 series. 

1. Before Using This Software 

Refer to P. 5-1 This part describes outline of setting up PROTEM2. To use Base tool 

Refer to P. 6-1 This part describes how to save the setting data to your 
computer and transfer the data to your instrument as well as 
logging method using the Logging tool.  
This part also shows how to make a list (report) of setting 
parameters. 

To conduct data 

management of 

instruments. 

Base tool 

To conduct a program 

control using the PZ 

series. 

To conduct a program 

control using the 

PF900 series. 

Setting tool for the PZ 

Setting tool for the PF900 
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2.1 Installing PROTEM2 
Proceed as follows to install the software. 
This procedure is based on Installer version 2.0.3.0 (English edition). 

 
1. Extract the [protem2_2030e.zip] downloaded from our website. 
 
2. Double click WixSetupENG1.msi found in the extracted folder. 
 

 
 
 
 
 
3. 
 
 
 
 
 
 
 
 
 
 
 
4. 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

2. Installing PROTEM2 

 To use this software Microsoft .NET Framework 4.5 or later is required. 

NOTE 

TIPS 

 In case any previous version of PROTEM2 is installed in your PC, you can install this version
without uninstalling it.* 

* If you have uninstalled the older version, the projects and log files created/changed with the older version will not be deleted by  
the uninstallation. Delete those manually, if necessary. 

Click [Next] 

① Read the Terms of Use of 
this software 

② Check the check box to indicate “I accept 
the terms in the License Agreement”  

③ Click [Next] 

Double click 
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(Continued from the previous page) 
 
5. 
 

If you wish to change the default installation location, click 
[Change…] and select the location of your choice. 
Click [Next] after you have changed the installation 
location. 

 
 
 
 
 
 
 
 
6. 
 

The User Account Control (UAC) dialog box will appear 
soon after you have started the installation. Click [Yes] to 
proceed. 

 
 
 
 
 
 
 
 
 
7. 
 

If the installation is successfully finished, the folder 
designated in procedure 5 (1) above will be created, the 
software will be registered to the start menu (2), and a 
short cut will be created on the Desktop (3). 

 
① 

 
 
 

② ③ 
 
 
 
 
 
 
 
This completes the installation process. 

TIPS 

TIPS 

TIPS 

2.1 Installing PROTEM2 

Click [Next] 

Default folder 

Click [Install] 

Click [Finish] 

Click [Yes] 
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2.2 Uninstalling PROTEM2 
To uninstall PROTEM2, follow the Windows program uninstallation procedure. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the uninstallation process of PROTEM2. 

2.2 Uninstalling PROTEM2

② Click [Apps] 

(Example: Windows10) 

④ Click [Uninstall] 

③ Click [PROTEM2 ver2.0.3.0_English] 

(When User Account Control screen is displayed) 

⑤ Click [Uninstall] 

⑥ Click [Yes] 

① Click here 
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3.1 Necessary Products and Cables 
To use PROTEM2, you need to establish a connection to allow Loader communication or Serial communication 
between the supported instrument and the PC. Refer to the following table for the communication converter and 
cables required for the connection. In this manual, the connection example between the PC and the supported 
model is explained using the typical model. 

Refer to the Instruction Manual of the relevant model for the details of wiring and connection of the supported 
models. The Instruction Manuals of the supported models can be downloaded from the official RKC website. 
 

● List of Necessary Products and Cables 
: Supported    : Connectable Converters and cables (//: Converter and cable with a circle of the same color mean that they can be used together.) 

Communication interface and 
available converters/cables 

 

 

Supported models 

Comm. interface USB converters 
(RKC) 1, 2, 3 

Comm. converters Comm. cable 
(RKC) 1, 5 Serial comm. 
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SRZ System Z-COM-A                

 Z-TIO-A/B/C/D                

 Z-DIO-A                

 Z-CT-A                

 Z-TIO-G                

SR Mini HG System                

SR Mini System                

SRJ * J-TI                

B400                 

FB series FB100                

 FB400/900                

FZ series FZ110                

 FZ400/900                

GZ series GZ400/900                

HA series HA400/900                

 HA430/930                

RB series RB100/400/500/700/900                

RD series RD100/400/500/700/900                

RZ series RZ100/400                

SA series * SA100/200                

SB1                 

AG500                 

PG500                 

NWS series * NWS-COM, NWS-COM-M1                

PZ series ** PZ400/900                

PF series ** PF900/901                

IOPD *                 

THV-A1                 

THV-40                 

THV-10                 

COM-KG (NWS wireless) *                

COM-ME series                

COM-ML series                
1 Our USB communication converters, RS-232C/RS-422A converters, and communication cables are all optional and sold separately. 
2 Our USB communication converters can be also used as a USB/serial communication converter for RS-422A or RS-485. 
3 To use the COM-K2, the USB driver must be installed on the PC. 
 The USB driver can be downloaded from the official RKC website: https://www.rkcinst.co.jp/english/download-center/ 
4 If you wish to use a commercial communication converter, you have to provide it by yourself. For example, Data Link products are shown above. 
5 W-BF-01 (Spade crimp terminal ←→ Modular connector)a  W-BF-02 (Modular connector ←→ Modular connector)a W-BV-02 (Modular connector ←→ Phoenix 5-pin connector)a 

  W-BF-28 (D-sub 9-pin connector ←→ Modular connector)a 

 a The standard length of each communication cable is 3 meters. 
 * This model is not supported by PROTEM2 (English edition). 
 ** Use Setting tool for the PZ series or the PF900 series which are supported by PROTEM2 (English edition). Base tool (English edition) does not cover this model. 

3. Connecting instruments to PC 
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3.2 Connections for Loader Communication 
This part of the document will show you an example of setting up the Loader communication using our instrument 
with the USB loader communication connector, together with our USB communication converter and the PC. 

 

 

 

■  Basic System Configuration 

 

 

 

 

 
1 To use the COM-K2, the USB driver must be installed on the PC. 
 The USB driver can be downloaded from our website. 
2 The Loader communication supports RKC protocol (based on ANSI X3.28-1976). 
3 Device address for the Loader communication is fixed at 0. The device address setting of the instrument is ignored. 
4 With the USB power supply (USB bus power) from our USB communication converter, communication can be 

established with the instrument connected with the loader communication cable. Note that some instruments 
will not operate from the USB bus power. Consult the instruction manual for details. 

 

 

■ Connection Example 

List of devices and cables used in the example 

 Connection type 1 (P. 3-3) Connection type 2 (P. 3-4) Connection type 3 (P. 3-5) 

Instruments with 
Loader 
communication 
connector 

 

SRZ System 
(Z-COM,  
Z-TIO/DIO/CT,  
Z-TIO-G) 

FB series 

PF series FZ series * 

USB 
communication 
converter 

COM-KG-□N 

COM-KG-1N COM-KG-3N COM-KG-4N 

With Loader communication cable 

W-BV-01-1500 

(Length: 1.5 m) 

 

With Loader communication cable 

W-BV-03-1500 

(Length: 1.5 m) 

With Loader communication cable 

W-BV-05-1500 

(Length: 1.5 m) 

 USB cable (Cable length: 1 m) [Supplied as standard] 

PC OS: Windows10 (64 bits)    USB port required (USB Ver.2.0) 

3.2 Connections for Loader Communication 

Communication settings on the PC 
(The following values are all fixed) 
Communication speed: Depends on the models 
Start bit: 1 
Data bit: 8 
Parity bit: None 
Stop bit: 1 
Communication port of the PC 
USB port: Based on USB Ver. 2.0 

Refer to the Instruction Manual of the relevant model for the details of Loader communication of 
the supported models. 

This digit indicates type of 
loader communication 
cable. COM-KG (main part) 
remains the same in each 
case. 

* Connection to the LOADER port on the PZ 
series is the same as this. 

To USB port 

USB communication 
converter 1 

(RKC product) 
Controller with the Loader 

communication 3, 4 

[Max. connection: 1] USB cable Loader communication cable 

PC 

COM-KG 
COM-K2 

2 
USB 

To Loader port 

Loader Comm. 
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● Connection Example 1: ① SRZ (Z-COM, Z-TIO/DIO/CT, Z-TIO-G) 

Z-COM module (used standalone)： 

 
 
 

 

 

 

 

Z-COM+(Z-TIO/DIO/CT)： 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Z-TIO/DIO/CT (stand-alone), Z-TIO-G (stand-alone)： 

 
 
 
 
 
 
 
 
 
 
 

3.2 Connections for Loader Communication

 When connected via the Loader port, the instrument is available for communication even when the instrument
power is off. However, measured values such as PV and CT may be uncertain. To do the PV logging, the
instrument needs to be powered on. 

TIPS 

 When the Z-COM module and two or more function modules (Z-TIO/DIO/CT) are connected, the Loader
communication is established only with the module to which the Loader communication cable is
connected. 

 To establish a communication with all modules connected below the Z-COM, you need to supply power
(24Vdc) to the modules. 

 Z-COM and Z-TIO-G modules cannot be used linked together. 

NOTE 

When connected via the 
Loader port, the instrument is 
available for communication 
even when the instrument 
power is off. 

TIPS 

 When connected via the Loader port, the instrument is available for communication even when the instrument
power is off. However, measured values such as PV and CT may be uncertain. To do the PV logging, the
instrument needs to be powered on. 

 To establish a communication link with multiple modules (control units), use the Serial communication 
(RS-485). 

TIPS 

W-BV-01-1500 

USB port 

Loader port 

COM-KG-1N 
USB 

USB cable 

Loader Comm. 

W-BV-01-1500 

USB port 

Loader port 

COM-KG-1N 
USB 

USB cable 

Loader Comm. 

Loader port 

W-BV-01-1500 

USB port 

COM-KG-1N 
USB 

USB cable 

Loader Comm. 
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● Connection example 1: ② FB series (FB100/400/900) 

 
 
 
 
 
 

The Loader port of the FB400/900 can be  
found also at the bottom of the instrument. 

 
 
 
 
 
 
 
 
 

● Connection example 2: PF series (PF900/901) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2 Connections for Loader Communication 

 When connected via the Loader port, the instrument can be powered off. However, measured values such
as PV may be uncertain. To do the PV logging, the module needs to be powered on. 

 Loader communication is for a 1 to 1 connection between the computer and the controller. To establish a
communication link with the FB controllers, use the Serial communication (RS-422A/RS-485). 

TIPS 

 When connected via the Loader port on the bottom of the instrument, the instrument is available for
communication even when the instrument power is off. However, values such as PV and Pattern monitor 
may be uncertain. To do the PV logging, the instrument needs to be powered on. 

 Loader communication is for a 1 to 1 connection between the computer and the instrument. To establish a
communication link with multiple instruments, use the Serial communication (RS-422A/RS-485). 

TIPS 

 Loader communication ports of the PF series are located on the front and on the bottom of the
instrument. Both ports cannot be used at the same time. You can only use one of the two at a time. 

 Be sure to turn ON the PF900/901 when using the Loader communication port on the front panel. 

 The Loader communication connector on the front panel is different from the one on the bottom of the
instrument. When using the Loader communication port on the bottom of the instrument, use the
W-BV-01-1500 loader communication cable. 

NOTE 

W-BV-01-1500 

USB port 

Loader port 
COM-KG-1N 

FB100 

USB 

USB cable 

Loader comm. 

USB 

USB cable 
W-BV-03-1500 

USB port 
Loader port (front) 

COM-KG-3N Loader comm. 

USB 

USB cable 
W-BV-01-1500 

USB port 

Loader port (bottom) 

COM-KG-1N Loader comm. 
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● Connection example 3: FZ series (FZ110/400/900) 
 
 
 
 
 
 
 
 

Loader port of FZ400/900 is also on  
the front panel. 

 
 
 
 
 
 
 
 
 
 

3.2 Connections for Loader Communication

 When connected via the Loader port, the instrument can be powered off. However, measured values such
as PV may be uncertain. To do the PV logging, the instrument needs to be powered on. 

 Loader communication is for a 1 to 1 connection between the computer and the controller. To establish a 
communication link with multiple instruments, use the Serial communication (RS-422A [for FZ400/FZ900 
only] or RS-485). 

TIPS 

W-BV-05-1500 

USB port 
Loader port (front) 

COM-KG-4N 

FZ110 

USB 

USB cable 

Loader comm. 



3-6 IMT01D11-E7 

 
 
 

3.3 Connections for Serial Communication 
We will show you an example of setting up the Serial communication using our instrument with the USB loader 
communication connector, together with our USB communication converter and the PC. 

 

 

 

■  Basic System Configuration 

When the serial communication interface is RS-232C: 
 

 

 

 

 

 
 

1 Communication cable, commercial USB/Serial communication converter, and D-sub 9-pin connector must be provided by the customer. 
2 Refer to the relevant document for the terminal screw size, recommended tightening torque, and recommended crimp terminals. 

 

 

When the serial communication interface is RS-422A: 
You can use our communication converter (COM-KG and COM-K2) as a USB/Serial communication converter. 

 

 

 

 

 

 

 

 

 
1 The Communication cable must be provided by the customer. 
2 Refer to the relevant document for the terminal screw size, recommended tightening torque,  

and recommended crimp terminals. 

 

 

 
 

Wiring example of when a commercial USB/Serial communication converter is used: 

 

 

 

 

 

 

 

 

RS-422A 

W-BV-02-3000 * USB cable 

3.3 Connections for Serial Communication 

TIPS 

* W-BV-02-3000 cable (RKC product) 

Remove the plastic part before use. 

Refer to the Instruction Manual of the relevant model for the details of Serial communication of the 
supported models. 

*R: Termination resistor (Example: 120 Ω 1/2W) 
 If communication errors occur frequently due to  

the operation environment or the communication 
distance, connect termination resistors. 

 The termination resistor must be provided by the 
customer. 

To USB port 

USB communication 
converter  

(RKC product) 

USB cable 

PC 

1 

2 

3 

4 

5 

SG  

T (A) 

T (B) 

R (A) 

R (B) 

Controller with  
serial communication  

(RS-422A) 

R (A) 

R (B) 

SG 

T (A) 

T (B) 

Supplied with Serial 
communication connector 

Pair cable 

RS-422A 

Twisted pair cable 1 
(with shield) 

Connected to RS-422A serial 
communication terminal 2 

Controller with  
serial communication  

(RS-422A) 

 

R (A) 

R (B) 

SG 

T (A) 

T (B) 

*R 

[Max. connection: 31] 

USB 

To USB port 

USB/Serial communication 
converter  

(commercially available) 1 
Controller with 

serial communication  
(RS-232C) USB cable 1 

Twisted pair cable 1 
(with shield) 

PC 

Connected to RS-232C serial  
communication terminal 2 

SG 

SD 

RD 

Short 

D-SUB  
9-pin connector 1 

Pair cable 

RS-232C 

[Max. connection: 1] 

RI (Not used) 
CTS (Not used) 
RTS (Not used) 
DSR (Not used) 
GND 
DTR (Not used) 
TXD 
RXD 
DCD (Not used) 

USB 

Controller  
(RKC product) 

DL-U422T 
Blue 
Black 
Red 
Orange 
White 

Blue 

Black 

Red 

Orange 

White 
Shield 

Twisted pair cable 
(with shield) 

RS-422A 
Controller  

(RKC product) 

DL-U422T 

USB cable 

Pair cable 
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When the serial communication interface is RS-485: 
 You can use our communication converter (COM-KG and COM-K2) as a USB/Serial communication converter. 

 

 

 

 

 

 

 

 

 
1 The RS-485 communication cable must be provided by the customer. 
2 Refer to the relevant document for the terminal screw size, recommended tightening torque,  

and recommended crimp terminals. 

 

 

 

 
 
 

Wiring example of when a commercial USB/Serial communication converter is used: 

 

 

 

 

 

 

 

 

 

 

 

Blue 

Black 

Red 

RS-485 

3.3 Connections for Serial Communication

TIPS 

*R: Termination resistor (Example: 120 Ω 1/2W) 
 If communication errors occur frequently due to the 

operation environment or the communication distance, 
connect termination resistors. 

 The termination resistor must be provided by the 
customer. 

To USB port 

USB communication 
converter  

(RKC product) 

USB cable 

PC 

Supplied with Serial 
communication connector 

Pair cable 

RS-485 

Twisted pair cable 1 
(with shield) 

Connected to RS-485 
communication terminal 2 

*R 

[Max. connection: 31] 

Controller with serial 
communication  

(RS-485) 

T/R (A) 

T/R (B) 

SG 

Controller with serial 
communication  

(RS-485) 

 

T/R (A) 

T/R (B) 

SG 

USB 

1 

2 

3 

4 

5 

SG 

T/R (A) 

T/R (B) 

Not used 

Not used 

Not used 

Not used W-BV-02-3000 * USB cable 

DL-U485 
* W-BV-02-3000 cable (RKC product) 

Remove the plastic part before use. 

Blue 
Black 
Red 

Shield 

Not used 
Not used 

Controller  
(RKC product) 

Twisted pair cable 
(with shield) 

Paired 
cable 

RS-485 

DL-U485 

USB cable 
Not used 

Not used 

Controller  
(RKC product) 
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■ Connection Example 

List of devices and cables used in the example 

 RS-232C connection  
(P. 3-8) 

RS-422A connection  
(P. 3-9) 

RS-485 connection  
(P. 3-11) 

Instruments 
with Serial 
communication 

 

SR Mini HG System 
 

 

FB series *1 

(FB400/900 only) 

SR Mini HG System 
 

 

FZ series *2 
(FZ400/900 only) 

※2 The configuration of the RS-422A serial 
communication terminal of the PZ series 
is the same as the FZ series. 

SRZ System  
(Z-TIO connected) 

 

FZ series *3 

 

※3 The configuration of the RS-485 serial 
communication terminal of the PZ series 
is the same as the FZ series. 

USB/Serial 
communication 
converter 

DL-U232A (commercially 

available)  

[Data Link KK] 

COM-KG-NN 

(RKC product) 
 

USB cable (Cable length: 1 m) [Supplied as standard] 

 

Communication 
cable 

W-BF-28-3000 (RKC product) 

 

 
*1 The FB series need D-SUB 9-pin connector 

and RS-232C cable (shielded twist pair cable). 

W-BV-02-3000 (RKC product) 

PC OS: Windows10 (64 bits)    USB port required (USB Ver.2.0) 

 
 
 

● Connecting over RS-232C: ① SR Mini HG System 

 
 
 
 
 
 
 

* Communication cable for RS-232C, USB/Serial communication converter, and D-sub 9-pin connector must be provided by the customer. 

 

Connector: 
When connecting this cable to the
COM-KG, use it as it is for RS-422A 
and disconnect R(A) and R(B) for 
RS-485. 

Serial communication
connector (supplied) 

3.3 Connections for Serial Communication 

USB port 

DL-U232A * 

D-SUB  
9-pin connector * 

USB cable * 

RS-232C 

W-BF-28-3000 (RKC product) 

Modular connector 
COM.PORT3 

Control unit 
USB 
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● Connecting over RS-232C: ② FB series (FB400/900 only) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Refer to the relevant document for the terminal screw size, recommended tightening torque, and recommended crimp terminals. 
2 Communication cable for RS-232C, USB/Serial communication converter, and D-sub 9-pin connector must be provided by the customer. 

 
 
 
 

● Connecting over RS-422A: ① SR Mini HG System 

 
 
 
 
 
 

[RS-422A] 

Pin No. Signal Symbol 

5 Receive R (B) 

4 Receive R (A) 

3 Send T (B) 

2 Send T (A) 

1 Signal Ground SG 

 
 

3.3 Connections for Serial Communication

F
un

c.
 

DL-U232A 
2 

D-SUB  
9-pin connector 2 

Paired cable 

Twisted pair cable 2 
(with shield) 

FB series 

FB400/900 Serial comm.1 

RS-232C 

Not used 

Not used 

Not used 

Not used 

Not used 

USB 

USB cable 

RS-232C 

Serial communication terminal 
(rear side) 

USB port 

Not used 

FB400 

Short 

5 
4 
3 
2 
1 

USB port 

Control unit 

Modular connector COM.PORT1 

RS-422A 

W-BV-02-3000 * 
(RKC product) 

USB cable 

USB 
Serial communication connector 
(Supplied) 

COM-KG-NN 

Max. 16 units 

Blue 
Black 
Red 
Orange 
White 

Shield 
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● Connecting over RS-422A: ② FZ series (FZ400/900 only) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 The Communication cable for RS-422A must be provided by the customer. 
2 Refer to the relevant instruction manual for the terminal screw size, recommended tightening torque, and  
 recommended crimp terminals. 

 
 

3.3 Connections for Serial Communication 

USB port 

USB cable 

USB 
COM-KG-NN 

Serial communication connector 
(supplied) 

FZ400 FZ400 FZ400 

RS-422A 
RS-422A 

Serial communication terminal 
(rear side) 

RS-422A 

FZ400/900 Serial comm.2、3 

*R: Termination resistor (Example: 120 Ω 1/2W) 
 If communication errors occur frequently due 

to the operation environment or the 
communication distance, connect termination 
resistors. 
The termination resistor must be provided by 
the customer. 

[Max. connection: 31] 

R (A) 

R (B) 

SG 

T (A) 

T (B) 

Pair cable 

Twisted pair cable 1 
(with shield) 

5 
4 
3 
2 
1 

FZ series 

R (A) 

R (B) 

SG 

T (A) 

T (B) 

*R 

F
un

c.
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● Connecting over RS-485: ① SRZ System (Z-TIO connected) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Refer to the relevant document for the terminal screw size, recommended tightening torque, and recommended crimp terminals. 
2 The Communication cable for RS-485 must be provided by the customer. 

 
 

● Connecting over RS-485: ② FZ series (FZ110/400/900) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 The Communication cable for RS-485 must be provided by the customer. 
2 Refer to the relevant document for the terminal screw size, recommended tightening torque, and recommended  
 crimp terminals. 

3.3 Connections for Serial Communication

USB cable 

USB 
COM-KG-NN 

Serial communication 
connector (supplied) 

RS-485 

Serial communication 
terminal 1 

Z-TIO 
Z-TIO 

Power and communication are internally connected. 

Base part 

Base part 

*R: Termination resistor (Example: 120 Ω 1/2W) 
 If communication errors occur frequently due to

the operation environment or the 
communication distance, connect termination 
resistors.  

 The termination resistor must be provided by 
the customer. *R 

Power supply 

Serial comm. 

(Max. connection for Z-TIO modules: 16) 

Main 
unit 

USB port 

Supply 24V dc power to the module.

NOTE 

RS-485 

Pair cable 

Twisted pair cable 2 
(with shield) 

5 
4 
3 
2 
1 

Do not connect anything to 
terminals 4 and 5. Z-TIO 

USB port 

USB cable 

USB 
COM-KG-NN 

Serial communication connector 
(supplied) 

FZ400 FZ400 FZ400 

RS-485 
RS-485 

Serial communication terminal 
(rear side) 

*R: Termination resistor (Example: 120 Ω 1/2W) 
 If communication errors occur frequently due to

the operation environment or the 
communication distance, connect termination 
resistors.  

 The termination resistor must be provided by 
the customer. [Max. connection: 31] 

RS-485 

SG 

T/R (A) 

T/R (B) 

Pair cable 

Twisted pair cable 1 
(with shield) 

5 
4 
3 
2 
1 

FZ series 

*R 

Do not connect anything
to terminals 4 and 5. 

SG 

T/R (A) 

T/R (B) 

FZ400/900 Serial comm.2、3 

F
un

c.
 

FZ110 Serial comm. 2 

F
un

c.
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4.1 Starting PROTEM2 
Proceed as follows to start PROTEM2. 

(This procedure is based on Installer version 2.0.3.0)  

 
 

 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
We will next set the Communication configuration. 

(Refer to Next page) 

② Click [Base Tool] 

TIPS 

③ Click [Select a model] 

A dialog box, “Select a model”, appears. 

PROTEM2 will start and show 
the first screen. 

(Initial display status) 

④ Choose “Model”, 
“Communication”, 
and “Communication 
protocol” 

For example,  
when you choose the FZ
series and the Loader
communication, the screen
should look as shown left. 

⑤ Click [OK] 

A dialog box for “Start-up type 
selection” is displayed. 

The Base tool will start. 

Selecting the Loader 
communication will auto- 
matically select the RKC 
communication. 

You can switch the language from 
Japanese to [English] or [Chinese 
(simplified characters)]. It should be 
noted, however, that the switched 
language may not support all models. 
To see if your instrument is supported 
by the selected language, refer to the 
List of supported languages (P. A-1). 

NOTE 

Changing the language on the Main 
menu (shown left) is temporary.  
To make a complete change of the
language, go to “Environment setting”
under “Setting” in each tool and
change the font at “Change font” to 
the font to be used in the selected
language. 

Click 

① Double click the icon 
on the desktop. 

The Base tool screen will appear. 

4. Starting/Ending PROTEM2 

You can also start PROTEM2
through clicking PROTEM2 in the
Windows start menu. 
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4.2 Configuring the Communication 
 Proceed as follows to configure the communication. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, you need to check the operation of communication. 
(Continued on the next page) 

4.2 Configuring the Communication 

Communication address of 
the connected instrument * 

* For the Loader communication, 
the communication address is 
fixed to "0". 

(This Base tool screen is for the FZ series.) 

Communication port number 
to which the COM-KG or 
COM-K2 is connected. 

Port No. 

TIPS 

If you want to see or set the communication address and communication port after closing the communication
parameter setting screen, click the [Com.set/Diagram], then you will find relevant screens. 

② Configure the communication 
environment * 

* For the Loader communication, set 
values will be displayed according to the 
instrument used. 

A 

③ Click [OK] 

Click 

① Configure the Communication port * 

* Configure the communication port 
according to the PC you use. If you are not 
certain about the communication port 
number, click the [Device Manager]   , 
then “Device Manager” will be shown where 
you can check the port number. 

A 
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4.3 Checking the Operation of Communication 
Proceed as follows to see if the communication can be properly established. 

 
1. Click the ONLINE/OFFLINE button to select an online status. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make sure the mode is online state. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.3 Checking the Operation of Communication

Online/offline status is toggled 

on each click 
Click [ONLINE/OFFLINE] button 

Online state 

The mode is switched to Online from Offline. 

TIPS 

You can also switch to the Online
status from the pulldown menu 
displayed when clicking the 
[OFFLINE]. 

Click 

Communication status is displayed with an animated icon. 

Data must be displayed when 

“Monitor item 1” is clicked. 
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4.4 Ending PROTEM2 
Proceed as follows to end PROTEM2. 

 

End PROTEM2 after designating the location where the data is saved： 

① Click “File” – “Save as” in the menu bar. 

When you have started PROTEM2 by selecting a model, you are unable to overwrite the project. 

② When the dialog box, “Specify the project name”, is displayed, enter the project name, and click [OK]. 

③ Click “File”, “Quits this application” in the menu bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

 
 
 
 
 
 
 
 
 To delete the project file 

Delete the whole folder that has a folder name same as  
the project to be deleted. 

 Back up the project 
It is recommended to regularly back up the project folder 
where the project is stored. 
 

 

 

4.4 Ending PROTEM2 

① Click 

③ Click 

① 

③ 

NOTE 

TIPS 

When the Base Tool is started, recently used
projects will be displayed in Recently used project in
the Start-up type selection dialog. Select a desired
project and click [OK]. 

TIPS 

① Select 
② Click 

Set values in the instrument will not be saved by
saving a project file only. To save the data, use
Recipe Tool (Refer to P. 6-1) or Backup Tool
(Refer to P. 6-21). 

PROTEM2 manages the instruments in the unit of 
projects. The project name you enter here will be the 
folder name where the project file is saved. 
 
You are unable to designate the location of the 
project file. 
The project file will be saved to the following folder. 
 
¥RKC_TOOL¥PROTEM_v2030E¥Project 

A folder with the same name as the project file will be
automatically created under the project folder, and
the project file is saved in this folder. ② 

② Click 
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End PROTEM2 without designating the location where the data is saved： 

① Click “File”, then “Quits this application” in the menu bar. 

② When the dialog box for “Save project” is displayed, click [No]. 

This dialog box appears when PROTEM2 was started after selecting a model or when the project was modified. 

③ Click “EXIT” in the menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.4 Ending PROTEM2

① Click 

③ Click 

The Menu screen will be displayed. 

② Click 



4-6 IMT01D11-E7 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Memo 



5-1 IMT01D11-E7 

 
 
 

5.1 Basic Setting for Loader Communication 
This part of the document explains the basic setting for the Loader communication when the Base tool of PROTEM2 
is used for the first time. 

 
 
 
 
 
 
 

■ Starting the Base Tool 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, you will set up the Communication Port. (Continued on the next page)

5. Getting Started with Base Tool 

② Click [Base Tool] 
③ Click [Select a model] 

PROTEM2 will start and show the first
screen. 

A dialog box for “Start-up type 
selection” is displayed. 

⑤ Click [OK] 

Select Z-TIO for model, Loader communication for 
communication, and click [OK]. 

Base tool 

The Base tool screen 
will appear. 

This part of the document describes a setting example when the Z-TIO is connected
through the Loader communication. 
(In this example, PROTEM2 (English edition) version 2.0.3.0 is used.) 

For the details of connection through the Loader communication, refer to 3.2
Connections for Loader communication (P. 3-1). 

Loader port

 The Loader communication is available even while the instrument
power is off. However, values such as PV and pattern monitor may be
uncertain. To check the PV (and other measured values), the
instrument needs to be powered on. 

 The Loader communication is a 1 to 1 connection between the PC
and the instrument. To establish a communication link with multiple
instruments, use the serial communication (RS-422A/RS-485). 

TIPS 

④ Select Z-TIO and Loader 
communication 

① Double click the icon 
on the desktop 
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■ Setting up Communication Port 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
 

Next, you need to check the Operation of Communication. 
(Continued on the next page) 

5.1 Basic setting for Loader Communication Connection 

TIPS 

Base Tool 
The COM port (communication
port) number depends on the
computer you use. 

Communication port to number 
which the COM-KG or COM-K2 is 
connected. 

Port No. 

Appropriate setting is displayed for the environmental
setting of the loader communication, and the users do
not need to set it up. 

Click the ONLINE/OFFLINE button (3) to select an online status. 

③ Click [ONLINE/OFFLINE] button 

Online/Offline status is toggled 
on each click. 

② Click [OK] 

A 

① Set up Communication port 

If you are uncertain of the port
number setting, click button A .  
The Device Manager appears and
you can check the port number of
your computer. 
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■ Checking the Operation of Communication 
Ensure that the system is online. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to set data, save a project file, and check other 
useful tips. 

 Refer to Page 5-21 and followig 
 
 

How to use various tools (e.g. Saving set data, 
backup of instrument, data logging and reporting 
functions) 

Refer to Page 6-1 and followig 
 
 

5.1 Basic setting for Loader Communication Connection
 

Data on the Z-TIO 
modules can be set 
and monitored now. 

Data must be displayed when 
“Temperature control monitor” is clicked. 

Communication status is displayed with 
an animated icon. 

To save the Base tool to
end, refer to 4.4 Ending
PROTEM2 (P. 4-4). 

Base Tool
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5.2 Basic Setting for Serial Communication 
This part of the document explains the basic setting for the Serial communication when the Base tool of PROTEM2 
is used for the first time. 

 
 
 
 
 
 
 
 

■ Starting the Base Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, you need to set up the Communication Condition.  
(Continued on the next page) 

5.2 Basic Setting for Serial Communication 

② Click [Base Tool] 
③ Click [Select a model] 

PROTEM2 will start and show the first screen. 

A dialog box for “Start-up type 
selection” is displayed. 

In the step of [Select a model], you need to select the FZ series,
serial communication and the communication protocol which
you use now. After selecting these, click [OK]. 

The Base tool screen 
will appear. 

Base tool 

⑤ Click [OK] 

Example 1 shows a setting example of when a single FZ400 is connected through
the Serial communication. 
(In this example, PROTEM2 (English edition) version 2.0.3.0 is used.) 

For the details of connection through the Serial communication,
refer to 3.3 Connections for Serial Communication (P. 3-6). 

<Example 1> 

When you use the serial 
communication, apply power 
to the FZ400. 

NOTE 

④ Select the FZ series, Serial 
communication, and RKC 
communication 

RS-485 

Serial  
communication 

① Double click the icon 
on the desktop 
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■ Setting up the Communication Condition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Next, you need to check the Operation of Communication.  

(Continued on the next page) 

Base Tool 

Communication port to number 
which the COM-KG or COM-K2 is 
connected. 

Communication speed and Data 
bit configuration: 
Set the settings same as the FZ 
connected to the system. 

Click the ONLINE/OFFLINE button (8) to select the Online status. 

⑧ Click [ONLINE/OFFLINE] button 

5.2 Basic Setting for Serial Communication

③ Click [Com.set/Diagram] 

⑦ Click [Close] 

④ Click [Address setting] 

A 

① Set up Communication 
port 

⑥ Click [OK] 

⑤ Set the Communication 
address 

② Click [OK] 

The COM port (communication
port) number depends on the
computer you use. 

You can check the communication 
settings, communication address and 
number of channels. 

Online/Offline 
status is toggled 
on each click. 

If you are uncertain of the port
number setting, click button A .  
The Device Manager appears and
you can check the port number of
your computer. 

Port No. 
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■ Checking the Operation of Communication 
Ensure that the system is online. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to set data, save a project file, and check other useful 
tips. Refer to page 5-21 and following. 

 
 

How to use various tools (to save the set data, back up the 
instrument data, conduct data logging, use the report 
function, etc).   Refer to page 6-1 and following. 

 
 

Now, you can monitor
and/or set the data of
the FZ400 controller. 

Data should be displayed 
when [Monitor item 1] is 
clicked. 

Communication status is displayed with an animated icon. 

To save the Base tool to
end, refer to 4.4 Ending
PROTEM2 (P. 4-4). 

Base tool

5.2 Basic Setting for Serial Communication 
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■ Starting the Base Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, you need to set up the Communication Condition. 
(Continued on the next page) 

② Click [Base Tool] 
③ Click [Select a model] 

PROTEM2 will start and show the first screen. 

A dialog box for “Start-up type 
selection” is displayed. 

In the step of [Select a model], you need to select the 
Z-TIO, Serial communication, and the communication 
protocol which you use now. 
Then, click the check box (), and click [OK]. 

A screen for specifying 
multiple quantity and/or 
multiple models will 
appear. 

5.2 Basic Setting for Serial Communication

⑤ Click check box 

⑥ Click [OK] 

Screen for “Selected multiple 
connections or multiple models” 

When the serial communication is 
used, the module must be powered 
(24 V DC). 

NOTE 

④ Select the Z-TIO, Serial 
communication, and RKC 
communication protocol 

This part of the document describes a setting example of when the Z-TIO and the Z-DIO
modules are connected through the serial communication. 
(In this example, PROTEM2 (English edition) version 2.0.3.0 is used.) 

For the details of connection through the Serial communication, refer to

3.3 Connections for Serial Communication (P. 3-6). 

<Example 2> 

Power 

supply 

RS-485 

Serial comm. 

Z-TIO Z-DIO 

① Double click the icon 
on the desktop 
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■ Setting up the Communication Condition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page.) 

Base tool 

① Check “Communication address” 
and “Number of channels” 

5.2 Basic Setting for Serial Communication 

Communication setting of Z-DIO 
Click the check box No.2 and select the Z-DIO
from the pulldown menu. 

Communication setting of Z-TIO 
Ensure that the communication address and  
the number of channels of the Z-TIO are properly set.  
Correct the settings, if necessary. 

② Click check box 

③ Select Z-DIO 

Communication setting of Z-DIO 
Set the communication address and the
number of channels of the Z-DIO 

④ Set the communication address and 
the number of channels of the Z-DIO 

⑤ Click [OK] 

The Base tool 
screen will appear. 

TIPS 

When you use multiple SRZ modules, set the address which will be used in the actual program. For the details of the 
address used in the actual program, refer to the instruction manuals of the instruments. 
 
Example: When the address setting switch of Z-DIO is set to "1" 

In the RKC communication, add "16" to the address set on the address setting switch. 
In the above example, the address is set to 17. 
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(Continued from the previous page) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, you need to check the Operation of Communication.  
(Continued on the next page) 

 

5.2 Basic Setting for Serial Communication

Base tool 

⑧ Click [Com.set/Diagram] 

⑨ Click [Address setting] 

⑥ Set up Communication 
port 

Port No. 

Communication speed and Data bit 
configuration: 
Configure the setting same as the Z-TIO 
and the Z-DIO already connected. 

A 

⑩ Make sure Comm. 
address and the No. 
of channels are 
correct. 

Click the ONLINE/OFFLINE button (13) to select the online status. 

Online/offline status is 
toggled on each click. 

⑬ Click [ONLINE/OFFLINE] button 

⑦ Click [OK] 

You can check the connection 
configuration, communication 
setting, communication 
address, and the number of 
channels. 

⑫ Click [Close] 

⑪ Click [OK] 

The COM port (communication
port) number depends on the
computer you use. 

If you are uncertain of the port
number setting, click button A .  
The Device Manager appears and
you can check the port number of
your computer. 

Communication port to number 
which the COM-KG or COM-K2 is 
connected. 
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■ Checking the Operation of Communication 
Ensure that the system is online. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to set data, save a project file, and check other useful tips. 
 Refer to 5-21 and following. 

How to use various tools (e.g. Saving set data, backup of 
instrument, data logging and reporting functions)  
 Refer to 6-1 and following 

Now, monitoring 
and setting of 
Z-TIO and Z-DIO 
are enabled. 

5.2 Basic Setting for Serial Communication 

Check communication operation of the Z-TIO 
Select “Temperature control monitor” in the tree view window, and make sure that the data is 
displayed (Communication is working). 

Communication status is displayed with an animated icon. 

If multiple modules 

(instruments) are 

connected, there are tabs

as many as the types of 

modules (instruments) 

connected. 

Check communication operation of the Z-DIO 
When “Monitor” is selected in the tree view window, and make sure that the data is 
displayed (Communication is working) 

If the tab of Z-DIO is 

selected, you can check 

the communication data of 

the Z-DIO. 

Communication status is displayed with an animated icon. 
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5.3 Screen Components and Menu Structure 
 

■  Screen Components 
The basic screen of the Base tool is explained below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu bar: Used to start functions of the Setting tool. 

For more details, refer to ■Menu Structure (P. 5-13) 

Various buttons:   
① ② ③ 

① [ONLINE/OFFLINE] button 
 Clicking this button enables to switch between               and                status 

② [Select user level] button 
 Used to select the user level. 

MONITOR:  Viewing only. Setting is not allowed. 

OPERATOR: Allowed to change settings in the modes except the Engineering and the Initial settings. 

ENGINEER: Allowed to change parameter settings in all modes including the Engineering and the Initial 

setting modes. 
 

 

 

 

 

 

③ [Comm.set/Diagram] button 

 Displays screens for Communication port, Device address, and Communication speed. 

(Continued on the next page) 

5.3 Screen Components and Menu Structure

Menu bar

Tree view
window

Data display area 

Model selector
tab

Select items
tab

Help window
(Explanation of

parameters)

Various buttons 

Help window  
(Parameters) 

Enable/Disable
Communication

check box

Gray colored White colored White colored 
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(Continued from the previous page) 

 

Model selector tab: Shows models connected to the Software. 
If two or more instruments of the same type or different types are connected, you can 
switch the screens between the connected models. 

Select items tab: Selected parameters can be grouped for display. 

Tree view window: Categorized monitor and set items are displayed in the tree view. Click a desired item 
to show the screen. 

Enable/Disable Communication check box: 
Uncheck items that do not need communication. This will increase the display update 
response of other parameters. 

 

In the recipe operation (data transfer), this setting (checked or not) is ignored. 
The data will be sent regardless of the setting. 
 

Data display area: The data of the parameters selected in the tree view are displayed. 

Help window (Explanation of parameters): 
Function, setting range and other information of the selected parameter are displayed. 

Help window (parameters): 
Parameter symbol of the selected parameter is displayed. 

 (Only for the models that show parameter symbols on the front display) 
 
 
 
 

TIPS 

5.3 Screen Components and Menu Structure 
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■ Menu Structure 
This page explains the commands launched from the menu on the menu bar. 
 
 
 

● File: Shows the File menu. 

Save: 
Saves (overwrite) the data to the existing project. 

Save as: 
Creates a project and save the data with a different name. 

Specify the reference data file: 
You can specify the backup file created with the Backup tool as the Reference 
data file to compare the backed up parameter settings with the current settings. 

Cancel reference data file specification: 
Cancels the specification of the reference data file. 

Quit this application: 
Clicking this item ends the application. 

 

● Edit: Shows the Edit menu. 

Copy: 

Copies the selected area to the clipboard. 

Paste: 
Pastes the copied area into the data field of the selected parameter. 

 

● View: Shows the View menu. 

Shows page tree window: 
Shows the page tree window. (Refer to example 1 on the following page) 

Shows reference data window: 
Shows the reference data window. (Refer to example 1 on the following 

page) 

Shows help window: 
Shows the help window. (Refer to example 1 on the following page) 

Show address and channel number as the channel name: 
Replaces the channel name with the address and the channel number. 
(Refer to example 1 on the following page) 

Optimize the width of the column: 
Optimizes the display width according to the width of the characters and the data 
now displayed. (Refer to example 2 on the following page) 

Font: 
You can choose a font (font, style, size) for the Base tool screen. 
The font specified here is temporary and is not saved. 
 

 
(Continued on the next page) 

Menu bar 

5.3 Screen Components and Menu Structure

To specify the font for the whole Base tool, refer to "Environmental
Setting" (P. 5-17). 
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(Continued from the previous page) 

Example 1 Example 2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Operate: Shows the operation menu. 

Online： 
Sets the communication status to online. 

Offline： 
Sets the communication status to offline. 

Change the user level to MONITOR *：  
Changing any parameters is not allowed. (Only monitoring is possible) 

Change the user level to OPERATOR *： 
The operator is able to change parameters except those in the Engineering and 
the Initial setting. 

Change the user level to ENGINEER *： 
The operator is able to change all the parameters including those in the 
Engineering and the Initial setting. 

Check all items of the page (online): 
Enables communication of all items. 

 

 

 
Uncheck all items on the page (offline) 
Disables communication of all items. (same as Offline status) 

 

 

 
 

(Continued on the next page) 

5.3 Screen Components and Menu Structure 

* The user level selected in 
the Operation menu is 
reflected in the displayed 
data, but is not saved. The 
user level at the next startup 
is the user level defined in 
the User level at startup in 
the “Environmental Setting”
(P.5-17). 

① 
② 
③ 
④ 

① 

④ ② 

③ ③ 

Address CH No. 

④ 

Before optimization 

After 
optimization 
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(Continued from the previous page) 

● Operate: Shows the Operation menu. 

Add the selected item to the “Selected items” 
You can collect parameters on different pages and those from another 
instrument and show them on the same tab. 

In addition to adding to the Selection tabs, you can delete the parameter items, 
insert a blank line, and make cutting and pasting.  

Refer to the following for the procedure. The operation is available in both online 
and offline states. 

 
How to add parameters： 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

How to delete parameters: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.3 Screen Components and Menu Structure

TIPS You can also add the selected item(s) to the Select items tab in the following way. 

② Click “Add select 
items” 

① Select the parameter (s) 
to delete, then right click 

TIPS You can also delete the selected item(s) from the Select items tab in the following way. 

③ The item will be added to 
the [Select items] tab 

① Select a desired 
parameter 

② Click “Add the selected item 
to the “Select items”” 

① Select a parameter to 
delete, then right click ② Click “Delete from 

select items” 

③ The item will be 
deleted from the 
[Select items] tab 

② Click “Delete from 
select items” 

③ The item will be 
deleted from the 
[Select items] tab 

① Select the parameter to 
delete, then right click 
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(Continued from the previous page) 
 
 

How to insert a blank line: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to cut and insert/paste: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(Continued on the next page) 

5.3 Screen Components and Menu Structure 

TIPS You can also insert a blank line into the “Select items” tab in the following way. 

① Select a cell above which 
a blank line should be 
inserted, then right click 

② Click “Insert a blank 
line” 

③ A blank line will be 
inserted to the [Select 
items] tab * 

* No adding is possible to a blank line. 

① Select a cell above which 
a blank line should be 
inserted, then right click 

② Click “Insert a blank 
line” 

③ A blank line will be 
inserted to the [Select 
items] tab * 

* No adding is possible to a blank line. 

TIPS You can also cut and paste in the “Select items” tab in the following way. 

① Select a parameter to 
move, then right click 

② Click “Cut the selected 
items” 

③ Click the line to 
which the cut item 
should be inserted, 
then right click 

④ The item will be pasted to 
the line where you want 
to insert it 

① Select a parameter to 
move, then right click 

② Click “Cut the selected 
items” 

The steps to follow are the same
as above 

TIPS No adding is possible to a blank line. 

No adding is possible to  
a blank line. It is skipped. 
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(Continued from the previous page) 

● Setting: Shows the setting menu. 

Address setting： 
Displays address setting screen. 

 

Port Settings： 
Shows the communication parameter setting screen. 

 

Communication settings and configuration diagram: 
Shows the controller configuration screen. You can check the 
communication environment setting and the project. Click “Address 
setting”, “Port Settings” to see the setting dialog box of each item. 

 

Project Settings： 
This item is not available with version 2.0.3.0. 

Environment Setting： 
You can set the environment setting of the whole Base tool. The new 
settings will be effective only after reboot. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.3 Screen Components and Menu Structure

You can set the User level at the startup. Display example of Environment setting 

You can specify the font and size for the whole Base tool. 

This is a setting for saving the data displayed in the Base tool in the html
format. To use the html output function, check “Use Html output function”. 

Output cycle (sec): 
0 to 100 (Default: 5) 
The file in the saving location will be overwritten at the output cycle time
intervals. 

 

Destination folder: 
You can specify the desired folder to which the data is saved. When the file
is saved, a file with the name of PROTEM nHTML (n: 1～5) will be
automatically created. (Up to 5 files are available) 

You can change the default communication port when you select a new project.  
If you change this default communication port, a newly created project after the reboot
will use this changed communication port. 

If you want to change the user level temporarily for the
displayed data, you can do it using the [Select user level]
button (P. 5-11) or in the “Operate” menu (P. 5-14). 

TIPS 

If you want to temporarily change the font displayed in the
Base tool, you can do it in the display menu (P. 5-13). 

TIPS 

Communication address setting screen:  
Refer to P. 4-2, P. 5-5, or P. 5-9 

Communication parameters setting screen:  
Refer to P. 4-2, P. 5-2, P. 5-5, or P. 5-9 

Controller configuration screen:  
Refer to P. 4-2, P. 5-2, P. 5-5, or P. 5-9 
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(Continued from the previous page) 

● Tool： Shows the Tool menu. 

Recipe tool: 
Starts the Recipe tool. You can conduct a centralized management of parameter 
setting (saving to the PC/transferring to the instrument). 

 
 

Logging tool: 
Starts the Logging tool. This function provides visualization of the data as well as 
data recording in CSV format. 
 
 
Backup tool: 
Starts the Backup tool. You can conduct a centralized management of the settings 
(saving to the PC, transferring to the instrument/verification). 

Backup tool: Refer to P. 6-21 
 
Report tool: 
Starts the Report tool. This tool is used to create a list (report) of parameters and 
save the data in CSV/HTML format. 

Backup tool: Refer to P. 6-28 
 
Line monitor: 
You can check the message just in communication according to the format (ASCII 
or hexadecimal). The Line monitor during the use requires high communication load. 
It is advisable to use it only when it is necessary. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.3 Screen Components and Menu Structure 

(Display example of Line monitor) 

: Stops updating the messages. 

: Starts updating the messages. 

: Erases the messages on the Line monitor screen.1 

: Saves the monitored messages in the text format.1, 2 

1 Regardless of start/stop status of the Line monitor, operations such as erase
and save can be done. 

2 When you try to save the file, a file name and a destination will be 
displayed, but you can freely change the file name and the saving location. 

Operation buttons 

Display format ( ): 

The display format of message is selectable. To change the format, 
stop the Line monitor and erase the message before selecting a new 
format. When you click the [Start] button, the Line monitor will start in 
the selected format. Vertical scroll bar: 

While the Line monitor is in stop, you
can scroll the Line monitor screen up
and down. 

Monitoring time (HMS or Hour, Minute, Second) 

Communication data (Display format: ASCII) 

Communication port number of the destination 

Communication data (Display format: Hexadecimal) 

Recipe tool: Refer to P. 6-1 

Logging tool: Refer to P. 6-10 
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(Continued from the previous page) 

● Tool： Shows the Tool menu. 

Controller status: 
You can check the connection status of the instrument now in communication and 
its error status. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Windows: Shows the window menu. 

 
This item is not available in this version. 

 

You can check the project name now open. 
 
 
 
 
 

(Continued on the next page) 

5.3 Screen Components and Menu Structure

(Display example of controller status) 

Operation menu 

Communication port number of the destination 

When you click “Exit”, the Controller status screen will
be closed. 

Click “Start” or              to save the log data of
the controller status.* 

You can check the error code and its meaning. 

* The name of the file (extension: csv) and the saving location of 
the file will be displayed. You can freely change the saving 
location and the file name. 

The “Stop” operation is enabled after the log data of the
control status is saved. 

[Status logging] button 

The actual connection status can be
checked. 

Click this button to erase the Error status 
display on the screen. 

You can check the error status
logging in communication. 

Erase operation is available anytime,
online or offline. Note that, in the online
mode, error logging continues from when
the erase operation is done till the error is
eliminated. 

TIPS 

This item remains “NoName” until the new project is saved after the start of
the Base tool. 

TIPS 



5-20 IMT01D11-E7 

 
 
 
 

(Continued from the previous page) 

● Help: Shows the help menu. 

Version information: Displays version information for the Base tool. 

RKC Home page:  Click to visit our website. 

 
 
 
 
 
 
 
 
 

5.3 Screen Components and Menu Structure 
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5.4 How to Set Data 
 
This part of the document explains the data setting method (changing numerical value, copy and paste of the data) 
using the Base tool. 
 

■ Setting Change of the Data 
 
 
 
 
 
 
 

● Changing the numerical value 

Example: Change the set value (SV) of Input 1 from 200.0 to 210.0 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.4 How to Set Data

 Setting change must be done online. If you try to change the data offline, the new 
value will not be reflected on the instrument. 

NOTE 

① Double click the cell 
you want to change. 

② A cursor appears and the cell 
is ready to be edited. 

③ Use a mouse to choose 
the digit to change. 

④ Click after entering "1". 
(The changed value is 
accepted) * 

* To accept the changed data, you can 
also press the ENTER key or move 
to the other cell in addition to the 
clicking. 

Copy and Paste: Refer to P. 5-23 

If the item you want to change is added to the
[Select items] tab, the change will be applicable to
the item in the [Select items] tab.  

If you changed the item that was added to the
[Select items] tab, the change is applicable to the
same item in the Model selector tab. 

TIPS 

While the cell is selected,
you can change the value
by entering the value from
the keyboard followed by
the ENTER key. 

TIPS 
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(Continued from the previous page) 

 

● Selecting the set item 

Example: Change the control response of Input 1 from “2: Fast” to “0: Slow” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.4 How to Set Data 

① Double click the cell 
you want to change 

② Pulldown menu 
is displayed 

③ Select “0:Slow” 
and click it 

④ The value will be 
changed from “2:Fast 
“ to “0：Slow” 

⑤ Press [ENTER] or move 
to another cell  

(The changed item is 
accepted) 

TIPS 

If the item you want to change is added to
the [Select items] tab, the change will be
applicable to the item in the [Select items]
tab.  

If you changed the item that was added to
the [Select items] tab, the change is
applicable to the same item in the Model
selector tab. 
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(Continued from the previous page) 

● Copy and paste (of the data) 

Example: Let's assume that the Event 1 set value (EV1) 15.0 is copied and pasted into the data cell of the Event 2 
set value (EV2) to change to 15.0 from 10.0. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.4 How to Set Data

① Click the cell you want to 
copy (Select the cell) 

② Right click on the selected 
cell. The pulldown menu will 
be displayed. 

③ Click “Copy” 

④ Click the cell to which you 
want to paste the data, right 
click to show the pulldown 
menu, and then click “Paste” 

When this data is sent 
to the instrument and 
accepted, the bold font 
state will be released. 

When copying and pasting the
data cell, you can select two or
more cells. 

TIPS 

⑤ Click [OK] 

The pasted data is 
displayed in bold font 
until it is accepted. 
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5.5 Saving a Project File 
 
This part of the document explains how to save the project file. 
 

■ Saving a New File 
When you save a new project file or save a project file with a different name, proceed as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   To delete the project file 
Delete the whole folder that has a project file name. 

 

 

 

 

 

 

 

 Back up the project 
It is recommended to regularly back up the project folder where 
project file is stored. 

5.5 Saving a Project File 

① Click 

③ Click 

NOTE 

TIPS 

Set values in the instrument will not be saved by saving a project file only. To save these data, use the
Recipe Tool (Refer to P. 6-1) or the Backup Tool (Refer to P. 6-21). 

TIPS 
A folder with the same name as the project file will be
automatically created under the project folder, and the
project file is stored inside this folder. 

A project file contains: 
・Communication setting 
・Base tool tree configuration (Page tree view ) 

Delete the folder 

Click 

 Overwrite the existing project file 

② Click 

It is recommended to create a project file 
with a name using the model code, name of 
machines, and other identifiable name. 

PROTEM2 manages the instruments in the unit of projects. The 
project name you entered here will be the name of the folder 
where the project file is saved. 

You are unable to specify the location of the project file. The 
project file will be saved to the following folder. 

¥RKC_TOOL¥PROTEM_v2030E¥Project 
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5.6 Opening a Project File 
 
This part of the document explains how to open a project file. 
 

■ Open the Project File Last Saved 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

■ Open a Project File not shown in recently used Project 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

5.6 Opening a Project File

The last saved project will be 
displayed. If multiple projects 
are displayed, select the one 
you want to use. 

A dialog box for “Start-up type 
selection” is displayed. 

② Click [OK] 

Project file used last time 

A dialog box for “Start-up type 
selection” is displayed. 

The Project folder 
is opened. 

③ Click the folder where the 
project file you want to use is 
stored 

① Click the [Base Tool] 

② Click 

① Click the [Base Tool] 
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(Continued from the previous page) 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Communication setting such as port setting and address setting is saved within a project file, and you do 
not need to set again. 

 
 
 
 

 

 
 
 
 
 
 
 
 
 
 

5.6 Opening a Project File 

④ Click the file with 
the extension ptj 

The file name is displayed here 

⑤ Click 

The project file to use 
will be opened. 

TIPS 
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6.1 Recipe Tool 
 
The Recipe tool is used to save the data set in the instrument on the PC or send the data retrieved from the PC to 
the instrument. It is recommended to prepare recipes for different processes, products, seasons and other 
categories. This enables easy configuration of the instrument only by transferring the recipe from the PC. The 
Recipe tool can be used as follows. 
 

①  Save the set data to the recipe file 
 The data in the instrument and the newly set data can be saved in (downloaded to) a project file as a recipe. 
 

Refer to P. 6-2 
 
 
 
 
 
 
 
 
 

②  Transfer the stored recipe file to the instrument 
The data in a recipe file stored in a project can be transferred (uploaded) to the instrument. 
 

Refer to P. 6-6 
 
 
 
 
 
 
 
 
 

③  Edit the stored recipe file 
Retrieve the recipe file stored in the project and edit it on the Recipe tool. 
 

Refer to P. 6-7 
 
 
 
 
 
 
 
 

6. Getting Started with Data Management 

P: 60 
I: 80 
D: 10 
ALM1: 50 
  
  

For Summer 

For Winter 

Recipe 

For Line A 

For Line B 

For Summer 

P: 60 
I: 80 
D: 10 
ALM1: 50 
  
  



P: 30 
I: 120 
D: 20 
ALM1: 50 
  
  



For Line A 

Recipe 
For Winter 

For Summer 

For Line B 

P: 30 
I: 120 
D: 20 
ALM1: 50 
  
  



For Line A 

Recipe 
For Winter 

For Line A 

For Line B 

P: 60 
I: 80 
D: 10 
ALM1: 50 
  
  



For Summer 
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6.1.1 Saving the Set Data in a Recipe File 
This is a function to save the data in the instrument to a project in PROTEM2. It is recommended to prepare recipes 
for different processes, products, seasons and other categories in advance. This enables easy configuration of the 
instrument only by retrieving the recipe from the computer. 
 
 
 
 For data protection, it is highly recommended to save the initial set values (factory set values) using the Backup 

tool (Refer to P. 6-21). 
 To transfer the data to the instrument, you need to set the Base tool to online. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1 Recipe Tool 

TIPS 

① Click “Recipe tool” 

② Click [Yes] 

③ Specify or enter 
the project name 

④ Click [OK] 

⑤ Click [New] 

⑦ Click [OK] 

Continued on the next page 

⑧ Click [OK] 

⑥ Click [RECEIVE] 
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Now the data set in the instrument has been saved (downloaded) as a recipe file. 
 
 
 

The recipe file has a memo function. You can store the file information and others in it. Click [MEMO] button to 
show the Memo screen. After entering the information, click [OK] to save and close the file. 

 
 
 
 
 
 

6.1 Recipe Tool

Continued from the previous page 

⑨ Click “Save As” 

TIPS 

⑪ Click [Save] 

⑩ Enter the file name 
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■ Adding/Deleting Recipe Items 
The items that can be saved in the recipe file are marked with ★ in the communication item name in the Base tool. 
You can add the recipe items in the following procedure. 
 
(Example) Add PV bias to the recipe item 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1 Recipe Tool 

Right click on the 
“PV bias” 

Click “Add to recipe items” 

★ marking added 

Now, the PV bias
has been added to
the recipe item. 

Add the PV bias to the stored recipe. 

Click “Recipe tool” 

Select a recipe file 

Click [OK] 

Add “PV bias” 

Click “Save” 

The PV bias has been added to 
the stored recipe. 

In case of [New] (create a new file), the
PV bias is added from the beginning. 

TIPS 
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(Example) Delete PV bias from the recipe items 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Simultaneously with the deletion of ★, the PV bias is deleted from the stored recipe file. 
 
 
 
 
 

6.1 Recipe Tool

Right click on the “PV bias★” 
Click “Delete from recipe 
items” 

★ marking deleted 

Now, the PV bias has 
been deleted from the 
Recipe items. 



6-6 IMT01D11-E7 

 
 
 

6.1.2 Transferring the Stored Recipe File to the 
Instrument 

The recipe file stored in the project on PROTEM2 can be transferred to the instrument. It is recommended to 
prepare recipes for different processes, products, seasons and other categories in advance. This enables easy 
configuration of the instrument only by retrieving the recipe from the computer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now the data in the recipe file has been transferred (uploaded) to the instrument. 
 

6.1 Recipe Tool 

① Click “Recipe tool” 
② Select a recipe file 

⑤ Click [OK] 

④ Click [SEND] 

③ Click [OK] 

The data in the recipe file is 
sent to the instrument. 
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6.1.3 Editing the Stored Recipe File 
You can edit the data in the recipe file on the Recipe tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Data setting method is similar to the Base Tool. (Refer to P. 5-21) 

 
 
 
After you have changed the settings, be sure to  
save the recipe file. 
 
 
 
 
 
 
 

6.1 Recipe Tool

① Click “Recipe tool” 
② Select a recipe file 

③ Click [OK] 

④ Change set value 
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■ Menu Structure in the Recipe File 
This part of the document explains commands launched from the menu in the recipe file. 
 
 
 
 
 

● File 
 

 
 
 
 
 
 
 
 

Save: The recipe data on the Recipe tool screen will be saved to the recipe file (extension p08) 
without changing the file name. 

Save As: The recipe data in the Recipe tool screen will be saved to the recipe file (extension p08) with 
a new file name. 

Send recipe settings: 
The recipe data on the Recipe tool screen will be sent to the instrument. 
The same operation can be obtained by clicking the [SEND] button. 

 
 
 
Receive recipe settings: 

The recipe data will be loaded on the Recipe tool screen. 
The same operation can be obtained by clicking the [RECEIVE] button. 

 
 
 
Remove the recipe you are viewing: 

The recipe file now displayed on the Recipe tool screen (extension p08) will be deleted. 

Return to the recipe list: 
The Recipe tool screen now displayed will be closed and the recipe file list will be displayed. 

 
 
 
 
 
 

(Continued on the next page) 

6.1 Recipe Tool 
 

Menu bar 

[SEND] button 

[RECEIVE] button 
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(Continued from the previous page) 
 

● Edit 
Copy: The data indicated by the cursor will be copied. Select multiple data 

by clicking and dragging over the screen to copy. 

Paste: The copied data can be pasted to the position of the cursor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● View 
Optimize column display width: 

Optimize the display width according to the width of the characters 
and the data in the table. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1 Recipe Tool

② Click “Copy” 

① Select items to copy 

③ Move the cursor to the location 
to paste copied items. 

④ Click “Paste” 

<Operation example> 

Copy 

Paste 

Before optimization 

After optimization 

The copied items 
are pasted 
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6.2 Logging Tool 
 
This is a tool to log various data including measured values and set values of the instruments connected via the 
Base Tool. The data can be graphically displayed on the computer and the logged data is saved in a CSV format 
which is editable with Excel and other popular software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

●Major functions of graphic display ●Major functions of logging 

 Selection of display items and the number of displays  Setting the logging cycle 
 Setting a time span  Splitting a log file 
 Automatic setting of data axis  Saving a report in a CSV format 
 Selecting the color of the background and   Display of statistical information 

the graph axis, Selecting the size of pens.  Display of saved data image 
 Dual Y axis display  
 Maximum 10 graphic groups 

 

6.2 Logging Tool 

Start/Stop logging button 
Show/Hide  
numerics button 

Graph display 

Set data display 
color Numeric display 

Show in graph/  
Not show in graph 
(Check box) 

Print button Select log data button 

 The graph display in the picture is just an example. The color of the background
and curves is selectable. 

ONLINE/OFFLINE button 

Enable/Disable 
plotting button 
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6.2.1 Starting the Logging Tool 
To start the Logging tool, select “Logging tool” on the Tool menu of the Base tool. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All setting data is saved individually in each project. 

6.2 Logging Tool

TIPS 

Click the box to change the color of the data. 

To manually change the color, you have to set the "Pen

color mode" to “Fix” in the setting of the Logging tool

(Refer to P.6-15). 

Uncheck to remove the data from the graph. 

Data is shown in the number of channels set in the

project. The default displayed content (logging item) is a

PV (measured value).  

Display items are freely selectable (Refer to P. 6-12). 

Drag the edge of the graph display area and
the logging tool to a desired size. 

TIPS 
Logging tool 

Click “Logging tool” 
Base tool 
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6.2.2 Pen Setting 
 
 

Before setting/removing communication items, make sure that the Logging tool is offline.  
You are unable to change settings online. 

 
To set up detailed settings, select “Pen setting”, which 
enables you to set up display items, graph No. (group), 
axis number, color and size of the pens, with/without 
display, etc. 
 
 
Tree view of graph display items (communication items) 

<To select communication items> (add items as shown in a. or b.) 

a. Select a desired communication item from the tree view and drag it to the desired pen.  

Use left click to set the communication item of one channel.  

Use right click to set the communication items of plural channels. (You can specify how many channels to set) 

b. Select a desired pen, then double click on the desired communication item in the tree view. 
 

<To delete the set communication item> 

Select the pen to be deleted, followed by [Delete] key. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

6.2 Logging Tool 

NOTE 

Logging tool 

Click “Pen setting” 

List of pens 

Unfolded view Folded view 
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Before changing the settings, make sure that the logging tool is offline.  
You are unable to change settings online. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

6.2 Logging Tool

NOTE 

Line width 
You can set the line width to draw a graph. 
Setting range: 1 to 9  

Graph items/Non-graph items 
Items without a check (unchecked items) will not be displayed
in the graph. 

Pen color 
Specify the pen color (line) used in the
graph. Click to select a desired color. 

Channel numbers of connected 
devices 

Graph number 
Specify the graph number (group) to which the item should
belong. You can set up to 10 groups (0 to 9). 

Axis No.  
You can set two types of data axes. 

Example: Axis 1 (PV), Axis 2 (MV) 
Each data axis can be individually scaled. 
・・・Refer to P. 6-14 (6.2.3 Logging setting/Display setting) 

Axis 1 (PV) Axis 2 (MV) 

In case of two group configuration (group 0 and 1) 

Group 0 

Group 1 

(Example) 

(Example) 
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6.2.3 Logging Setting/Display Setting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

6.2 Logging Tool 

If you select “Logging setting” in the
logging tool menu, you can set up detailed
logging and display configuration. 

During the logging, changing the setting
of logging details is invalid. 

TIPS 

You can define the prefix part of the logged data saved in a 
CSV format. 

The strings after the prefix are : 
year_month_day_hour_minute_second_division numbers 

Logging cycle 

For msec : 50 to 1000 msec. 
For sec.: 1 to 3600 sec. 

You can change fonts used for communication items
and channel display. 
For the channel display on the graph you can choose
from “Channel number” or “Channel name”. 

You can define the title that appears in a logged data file saved
in a CSV format. 

You can specify the number of the maximum logged data to be split. 

Example: If Split is set to 100 

File 1 

Log 100 

Log 1 File 2 

Log 200 

Log 101 File 3 

Log 300 

Log 201 

Initialize the setting content of Logging/Display. 

Logging tool 
Click “Logging setting” 
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All setting data is saved individually in each project. 
 

6.2 Logging Tool

TIPS 

X-axis (Time axis) 

For [sec]: 1 to 60 seconds 
For [min]: 1 to 60 minutes 
For [hour]:  1 to 60 hours 
For [day]: 1 to 60 days 

Graph number (group) tab 
You can set and assign the above settings individually up to
10 different graphs. 
Channel assignment to each graph can be done in Pen
setting (Refer to P. 6-13). 

Selection to show/hide (enable/disable) numerical 
values in the graph. 

The same result of operation is obtained when 
[Numeric] button is clicked. 

Selection of automatic color assignment or manual
assignment 
If you select “Fix” (manual), you can manually select
colors on the graph. 

Graph axis color 
Graph background color 

Show/Hide numerics button 
([Numeric] button) 

Graph scroll time 

Y-axis 1 Y-axis 2 
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6.2.4 Starting/Stopping Logging and Saving the 
Logged Data 

● Start/Stop logging 

Start logging 
When you select [Log start] (Start logging) on the Log start/stop button, the logging is started and the graph is drawn. 
 
 
 
 
 
 

Stop logging 
When you select [Log stop] (Stop logging) on the Log start/stop button, a message "Stop logging and 
communication." is displayed. Click [OK] to accept. Logging stops when [OK] is clicked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Logging can be started/stopped under “Logging Start/Stop” 

in the Operation menu. 
 
 
 
 
 
 When you select “Disable plotting” on the [Enable/Disable 

plotting] button, the display plotting stops. Note that even 
under this state, data logging continues. When you switch 
the mode to “Enable plotting”, the graph display starts 
logging, and the data during the stop will be also displayed. 
You can enable/disable plotting also on the Logging tool 
setting menu. 

 
 
 
 

6.2 Logging Tool 

[Log start/stop] button 

TIPS 

Enable/Disable plotting button 
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● Save log data 

The log data is saved in a single file (in a CSV format) which is created when the log starts and closed when the log 
stops. 

Maximum number of logged data in a single file can be set in “Split size” in the Logging setting. (Refer to P. 6-14) 
 
 
 

If you abort the Logging tool during the logging, a message "Stop logging and communication." appears. Logging 
is stopped when [OK] is clicked and data up to that time is saved in a file. 

 
 

● View logged data 

The logged data previously recorded can be displayed on the Logging tool. When you click the [File] button on the 
Logging tool, a folder containing the data will open. This folder is automatically created when a log is saved and the 
data is stored in this folder.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.2 Logging Tool

TIPS 

① Click [File] 

② Select log data 

③ Click [Open] 

④ The selected log data 
is displayed 
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6.2.5 Other Functions 

● Statistics 
The statistical information includes logging start date/time, number of logging (count), maximum/minimum values, 
sum, and average. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pen No.: Same number as the Pen setting. 

Reset Clicking at  (one by one) enables reset of the statistical data.  
The saved logged data will not be reset.  
When you click the [Reset all] button, all the statistical data will be reset. 

Item: Individual log data of each pen. 

Start date: Date when the logging was started. 

Start time: Time when the logging was started. 

Count: Number of the logged data. 

Minimum: The minimum value in the log data. 

Maximum: The maximum value in the log data. 

Sum: Total value of the logged data. 

Average: Average value of the logged data. 

 
 

6.2 Logging Tool 

Click [Statistics] 

(Display example) 



6-19 IMT01D11-E7

 
 
 
 
 

● Logging data 

The logged data is saved in a file (CSV format). You can view the logged data without opening the file in a CSV 
format as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Print 

Print the displayed graph. 
 
 
 
 
 
 

6.2 Logging Tool

Click “Logging data” 

Title set in Logging setting (Refer to P. 6-14) 

Log data name 

Log data channel 

Log data acquisition date (yyyymmdd) and time (hhmmss) 

Log data item: [Measured value (PV)] 4 channels 

Log data item: Manipulated output (MV) Monitor [Heating] 4 channels 

(Display example) 

Maximum data display:  

The latest 32 data will be displayed. 

Click “Print” 

or 

Click [Print] 
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● Changing Layout 

When there are multiple graph groups, display style on the screen can be selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.2 Logging Tool 
 

Select one graph to 
display in the maximum 
size (full). 
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6.3 Backup Tool 
 
The Backup tool is a tool to save the whole data in the instrument into a computer (backup), transfer the stored data 
back to the instrument (restore), and make comparison between the stored data and the data in the instrument 
(verify). 
This tool may be suitable for transferring the data for replacement, cloning the configuration, verifying the data inside 
the instrument for checking data falsification and unexpected data change. 
It is recommended to back up the configuration at the time of delivery (factory default) so that the instrument can be 
configured to factory default setting at any time. The backup tool is used at the unit of a project. 
 

① Save all settings as a Backup File (Batch saving) 
All the data in the instrument is backed up to a project (batch saving). 
 

 

 

Refer to P. 6-22 
 

 

 

 

 
 

② Restore Backup Files to the Instrument 
The data in a backup file stored in a project can be restored (uploaded) to the instrument. 

 
 
 

Refer to P. 6-24 
 
 
 
 
 
 
 

③ Verify the Backup File and the Data in the Instrument 
The software verifies the data between the backup data and the data in the instrument for any inconsistency. 

 
 
 

Refer to P. 6-26 
 
 
 
 
 
 

6.3 Backup Tool

Backup 

 All settings 
Backup file 

Restore 
 All settings 

Backup file 

Verify  All settings 

? 
Backup file 
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6.3.1 Saving All Settings as a Backup File (Batch Saving) 
You can back up the data in the instrument to a project (batch saving). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.3 Backup Tool 
 

① Click “Backup tool” 

② Click [OK] 

Backup Tool Screen 

Check the “Line monitor” to monitor 
the communication status between 
the PC and the instrument during 
the Backup process. 

When “Also create a CSV file” is 
checked, a file in a CSV format 
will be created simultaneously at 
the time of Backup. 

③ Click [Backup - batch save] 

④ Click [Next] 

Continued on the next page. 

 Screen configuration 
depends on the connected 
instruments. 

Backup 

 All settings 
Backup file 
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The backup file is saved in the project folder with an 
extension p18. 

 
 
 
 

6.3 Backup Tool

⑤ Enter a desired file name 

⑥ Click [Save] 

⑦ Click [OK] 

Continued from the previous page 

Status display 

Backup Tool Screen 

TIPS 
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6.3.2 Restore Backup File to the Instrument (Batch setting) 
The data in a recipe file stored in a project can be transferred to the instrument at a time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.3 Backup Tool 

① Click “Backup tool” 

② Click [OK] 

Backup tool screen 

Check the “Line monitor” to monitor 
the communication status between 
the PC and the instrument during 
the Restore process. 

③ Click [Restore - batch load] 

④ Select a Backup file 

Continued on the next page 

⑤ Click [Open] 

Restore 
 All settings 

Backup file 
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6.3 Backup Tool

* Screen configuration depends on 

the connected instruments 

Continued from the previous page 

If “Also perform Verify” is 
checked, verify is started after 
restore is completed. 

⑥ Click [Next] 

⑦ Click [OK] 

Status display 

If “Also perform Verify” is not checked 

If “Also perform Verify” is checked 

Verify result 

Backup tool screen 
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6.3.3 Verifying between the Backup File and the Data in the 
Instrument 

Verification is carried out between the setting data of the instrument and the backup data. This enables verification of 
the setting to see if the file might have been unintentionally changed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.3 Backup Tool 

① Click “Backup tool” 

② Click [OK] 

Backup tool screen 

Check the “Line monitor” to monitor 
the communication status between 
the PC and the instrument during 
the Verify process. 

③ Click [Verify - Compare the backup file and the controller] 

④ Select the backup file 

Continued on the next page. 

⑤ Click [Open] 

Verify  All settings 

? 
Backup file 
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6.3 Backup Tool

Continued from the previous page 

⑥ Click [Next] 

⑦ Click [OK] 

Status display 

Backup tool screen 

Verify result 

 Screen configuration depends on 

the connected controllers. 
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6.4 Report Tool 
 
The Report tool allows the whole setting data of the instrument to be reported in a format easily viewed. You can 
choose the data items to be included in your report. The report can be output to the printer or saved in a CSV or 
HTML format. 
 

6.4.1 Starting the Report and Setting up the Output 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

6.4 Report Tool 

Click “Report tool” 

Click “Output” 

Enter your own report title 

Checked items are 
displayed in the report. 

Note that display per 
group (number of 
rows) is limited by the 
setting of number of 
rows. 

Report tool example 
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When “Parameter symbol” is checked, the report tool will add parameter 
symbols displayed on the instrument to each communication item. For 
the instruments that have no parameter symbols such as SRZ, no 
parameter symbol will be displayed even if Parameter symbol is 
checked. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click the [Update] button to update the report with the latest data. 
 
 
 
 
 
 

6.4 Report Tool

TIPS 

When checked (Example) 

Parameter symbols are displayed in a 
bracket. 

[-] is displayed if there is no parameter 
symbol. 

(Some instruments may display nothing.) 

TIPS 

Click [Update] 
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6.4.2 Outputting Report Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.4 Report Tool 

Example of opening an HTML file with
Microsoft Edge 

Example of opening a CSV file with
Microsoft Excel 

Click to save the file in 
HTML format. 

Save the file in a desired 
folder. 

Click to send the file to a printer (print a report) 

Click to save the file in CSV format. 

Save the file in a desired folder. 

Report preview screen 
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This chapter 7 is not available with  

PROTEM2 English Edition. 
 

Chapter 7  
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8.1 Preparation 

■ Starting the Setting Tool for the PZ series 
Start the Setting Tool for the PZ series in the following procedure. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Direct mode: Choose this mode to monitor or modify the data of the PZ400/PZ900 connected to the 
network. Connect the PZ400/PZ900 to the PC, then click [Direct Mode] button. 

■ If You Have Chosen the Direct Mode → Refer to P. 8-2 

File mode: Choose this mode to open the settings file (extension p26) of the PZ400/PZ900 stored in the 
PC. This mode is for maintenance and is used to view the setting data or make a bulk (batch) 
setting for recovery and copy. 

■ If You Have Chosen the File Mode → Refer to P. 8-3 
 
 
 

① Click [Setting tool for 
PZ series] 

② Choose a mode 

TIPS 

You can choose a language from 
the following: 
“Japanese (1041)” 
“English (1033)” 
“Simplified Chinese (2052)” 

8. Getting Started With Setting Tool for PZ Series 
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■ If You Have Chosen the Direct mode 
Ensure that the PZ400/PZ900 is connected to the PC, then operate as follows. In this example, loader 
communication is used. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.1 Preparation 

① Click [Direct mode] 

② Configure the communication port * 

* Configure the communication port according to 
the PC you use. If you are not certain about the 
communication port number, click [Refer to 
Device Manager]    , then “Device Manager” 
will be shown where you can check the port 
number. 

A 

④ Click [OK] 

③ Check 
“Using the 
loader port” 

If you check “Using the loader port”, the
communication environment will be
preset for the loader communication.
You don't have to set it by yourself. 

⑤ Monitor screen is displayed “Direct mode” will come up 

TIPS 

A 
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■ If You Have Chosen the File mode 
You can read the settings file of the PZ400/PZ900 (extension p26) stored in the PC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.1 Preparation

① Click [File mode] 

② Select a file and double click it 

③ Monitor screen is displayed “File mode” will come up 
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8.2 Screen Components and Menu Structure 

■ Screen Components and Functions 
Components common to each screen are explained. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu bar: Used to start functions of the Setting tool. 

For more details, refer to ■ Menu Structure (P. 8-6). 

Window for switching screens: 
Screens in the window can be switched. Click the name of screen in the tree view 
window to switch screens. 

Mode status monitor: Displays the mode status. 
File mode: Displayed in the File mode. 
Direct mode: Displayed in the Direct mode. 
RESET: Lights during the Reset (RESET) mode. 
RUN: Lights during the Program control (RUN) mode. 
FIX: Lights during the Fixed setpoint control (FIX) mode. 
MAN: Lights during the Manual control (MAN) mode. 

Screen switch tab: Clicking the tab will switch the screen. 

Data display area: Displays various data. 

[Send] button: Writes data set with the setting tool to the PZ400/PZ900. This button is displayed in the 
Direct mode.  
(This item is not displayed on the monitor screen) 

 
(Continued on the next page.) 

8.2 Screen Components and Menu Structure 

Menu bar 

Window for 
switching 
screens 

Mode status 
monitor 

Screen 
switch tab 

Data display
area 

[Send] button [Receive] 
button 

“Repeated receive” 
check box 
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(Screen components continues) 
 

[Receive] button: Used to read the monitor and setting data of the PZ400/PZ900 to the Setting tool. This 
button is displayed in the Direct mode. 

Data is read out from the PZ400/PZ900 when the Setting tool is started, the data is 
sent, or the screen is switched. If the screen is left as it is, the data will not be read out 
and the screen will not be updated. To display the latest monitored and set data, click 
[Receive] button to read out the data. 

“Repeated receive” checkbox:  
The monitor data of the PZ400/PZ900 is automatically read out to the Setting tool at 
regular intervals (every few seconds).  

To read out the data at the regular intervals, check “Repeated receive”. This item is 
displayed on the Monitor and Driving operation screens. 

 

8.2 Screen Components and Menu Structure
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■ Menu Structure 
This page explains the commands launched from the menu on the menu bar. 
 
 
 
 
 

● File 
Direct mode File mode 

 
 
 
 
 
 
 
 

Save settings to file (controller → file) [Direct mode]: 
The setting data is read out from the PZ400/PZ900 and saved to the PC as a settings file 
(extension p26). 

Refer to ■ Saving Set Data of the PZ400/PZ900 to the PC (P. 8-28) 

Read file (file → PC) [Direct mode and File mode]: 
Read out the setting data stored in the PC (extension p26) into the Setting tool and switch the 
mode to the File mode. 

Refer to ■ Reading the Data of the Settings File into the Setting Tool (P. 8-30) 

Save it as a file with a name (PC → file) [File mode]: 
The setting data of the Setting tool is saved to the PC as a settings file (extension p26). 

Refer to ■ Saving the Data of the Setting Tool to the PC (P. 8-31) 

Bulk setting (PC → Controller) [File mode]: 
The setting data of the Setting tool is written into the PZ400/PZ900 in batches. 

Refer to ■ Writing the Data of the Setting Tool to the PZ400/PZ900 in  
a Batch (P. 8-33) 

Checking set value (Controller <-> PC) [File mode]: 
Verify if the setting data of the settings file (extension p26) will match the setting data of the 
PZ400/PZ900. 

Refer to ■ Verifying if the Data of the Setting Tool Matches the Data of the  
PZ400/PZ900 (P. 8-35) 

 
 
 
 
 

(Continued on the next page) 

8.2 Screen Components and Menu Structure 

Menu bar 
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(Continued from the previous page) 
 

● Setting 
 
 
 
 

 
Communication settings: Used to set communication parameters. Switch to the Direct mode after the 

setting is completed. 

Comm. port name: COM1 to COM256 

Refer to P. 8-2 for how to identify  
the communication port. 

Address: 0 to 99 (Maximum connections: 31) 

Speed: 2400 bps 19200 bps 
4800 bps 38400 bps 
9600 bps 57600 bps 

Data bits: 7 bit, 8 bit 

Parity bit: None, even, odd 

Stop bit: 1 bit, 1.5 bit, 2 bit 

Send delay time: 0 to 500 ms 

 

 
 
 
 

Trend Graph Settings 
Used to set parameters required for the Trend graph display. 

Refer to ■ Setting Up Trend Graph (P. 8-22). 

Font: Used to set the character font to be displayed on the Setting tool screen. 

 

● Mode 
Direct Mode/File Mode 

Choose a mode. 

Trend Graph ON/Trend Graph OFF: 
Used to set on/off the Trend graph. 

Refer to ■ Starting/Stopping Recording the Trend 
Graph (P. 8-24) 

Allow change of engineer mode: 
Choose this option when changing the settings in the 
Engineering mode. 

Show Extended Engineering Mode Item: 
Used for maintenance. 

(Continued on the next page) 

8.2 Screen Components and Menu Structure

Check “Using the loader port” for 
loader communication. 

You can check the communication port number
in the Device Manager in Windows. 

Use this option when the data cannot be obtained from the
Device Manager. 
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(Continued from the previous page) 
 

● Help 
Version Information: Displays version information for the Setting tool. 

Note Window: When you click the title of the monitor and set items, 
explanation about the item will be displayed. 

Register Map: Displays the data map for each register type during the 
PLC communication. This option is available when 
Communication protocol (Engineering mode, Fn60) is “3: 
PLC communication”. 

Example of PLC register map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.2 Screen Components and Menu Structure 

Engineering mode 
Setting items in PLC 
communication in Fn62 

Engineering mode 
Setting items of input types in  
Fn21 

Engineering mode 
Setting items in PLC 
communication in Fn62 

Engineering mode 
Setting items in communication 
setting in Fn60 

Outputs the PLC register map

in the CSV file format. 
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8.3 Program Setting Example 

■ Preparing a Program to be set 

We use the following program example to explain the setting procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Event 1 set value: 10°C 

 Number of repeating patterns: 2 

 Pattern link: No link 

 

 

The above program pattern consists of the following data. 
 

Pattern number 1     

Segment number 1 2 3 4 5 

Segment level 150 C 150 C 250 C 250 C 100 C 

Segment time 30 min. 45 min. 45 min. 70 min. 40 min. 
 

Time signal number 1 2  Pattern end output time 30 sec. 

Time signal start segment number 2 4  Event 1 set value 10 C 

Time signal start time 10 min. 15 min.  Number of repeating patterns 2 

Time signal end segment number 3 5  Pattern link number 0 (No link) 

Time signal end time 20 min. 10 min.    
 

 
 

(Continued on the next page) 

8.3 Program Setting Example

0 Time 

Level 

SEG1 

30 min. 

SEG2 
45 min. 

SEG3 
45 min. 

SEG4 
70 min. 

SEG5 
40 min. 

Program pattern 1 

Time signal output 

(Output to DO1) 

OFF ON 

Pattern end 
point 

Program start 
point  
(Zero start) 

OFF ON Pattern end output 

(Output to DO2) 

100 C 

150 C 

250 C 

10 min. 20 min. 

30 sec. 

Control 
continues 

15 min. 

ON 

10 min. 

Time signal 1 (TS1) Time signal 2 (TS2) 
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The following values are used for the program related initial setting parameters. 
 

 Engineering mode 

Fn00, 10 Time unit 

Time unit of the setting 1: minute : second 

Segment setting change type 0: Change action 1 

Store segment setting change 0: Keep setting change 

Fn34 DO Function 
DO1 function selection 7: Time signal 

DO2 function selection 8: Pattern end signal 

DO1 time signal selection 0011: Time signal 1: Valid 
Time signal 2: Valid 
Time signal 3: Invalid 
Time signal 4: Invalid 

Fn41, 42, 43, 44 Event 
Event 1 type 1: Deviation high  

 (SV monitor value) 

Event 1 hold action 0: No hold action 

Event 1 differential gap 2 C 

Event 1 timer 0.0 seconds 

Fn45, 46, 47, 48 CT 

Time signal selection 0011: Time signal 1: Used 
Time signal 2: Used 
Time signal 3: Unused 
Time signal 4: Unused 

Pattern end signal selection 1: Used 

 
 Setup setting 

Setup setting 1 

Wait zone high 10 C 

Wait zone low 10 C 

SV selection at Program start 0: Zero start 

Control action at Pattern end 0: Control continued 

Output action at Pattern end 7: Action continues  
(Logical calculation output, 
Retransmission output, 
Instrument status output) 

 

 
Refer to Instruction manual for PZ400/PZ900 (IMR03B05-E□) for details of each function. 

 
 
 
 

8.3 Program Setting Example 
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8.4 Program Setting 

■ Setting Program Related Initial Parameters 

1. Switch the mode to the Direct mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Set up to allow changes in the Engineering mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Ensure that the current mode is the Reset mode. 
 
 
 
 

 

 

If you are not in the RESET mode, switch the mode to “0: Reset mode (RESET)” in the Driving operation 
screen. 

 

8.4 Program Setting

① Click “Direct Mode” 

Click “Allow change of engineer mode” 

When this is checked, 
changes in the Engineering 
mode is possible. 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Make sure that the 
RESET lamp is lit 

TIPS 

Refer to P. 8-2 and P. 8-7 for 
Communication parameters. 
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4. Set up the program related initial parameters referring to the setting example on P. 8-10. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Set other parameters other than the program related parameters, if necessary. 

8.4 Program Setting 

When you finished setting up each screen,
click the [Send] button to write the set data to
the PZ400/PZ900. 

TIPS 
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■ Setting Program Pattern 
1. Switch to the “Patten setting (1)” screen, and set the program pattern referring to the setting example on page   

P. 8-9.  
(Enter values in the fields surrounded by a red frame)  
When you finished setting up the program pattern, click the [Send] button to write the set data to the PZ400/PZ900. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copy pattern: Copy the pattern currently displayed to another pattern No. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.4 Program Setting

Pattern will be 
displayed according to 
the Segment (SEG) 
level. 

Scroll the displayed 
segments 

< > Scroll by one segment. 

<< >> Scroll by 8 segments 

Used to copy a pattern. 
(See below) 

① Click [Copy pattern] 

② Select “Copy destination 
pattern number” 

③ Click [OK] 

④ Click [OK] and then 
[Send] button 

The pattern will not be copied unless the 
[Send] button is clicked. 

Pattern Graph 

Displays segment level, segment time, and time signals. 
(Refer to the next page) 

[Send] button 

Click “Patten setting (1)” 
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Pattern graph: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pattern Displayed according to the segment levels and time (SEG time). The number of 
displayed segments is determined by the Pattern end SEG number. The 
Segment width on the graph varies according to the Segment time length. 

Maximum and minimum values of the Pattern graph  
The values will be automatically displayed adjusted to the maximum and 
minimum values of the Segment level. 

Time signal 
Time signals are displayed adjusted to the Time signal setting.  
Start/End segments and the status of start/end time can be also displayed.  
Time signals 1 to 4 can be simultaneously displayed. 
 

Total of Segment time (SEG time)  
The total Segment time (Program pattern time) is automatically displayed. 

 
 
 
 
 

8.4 Program Setting 

Maximum and 
minimum values of 
the Pattern 

Total of Segment time (SEG time) 

Pattern 

Time Signal 1 (TS1) 

Time Signal 2 (TS2) 
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2. Switch the screen to the “Pattern setting (2)” screen, and set the program pattern referring to the setting example 

on page P. 8-9. 
(Enter values in the fields surrounded by a red frame) 
When you finished setting up the program pattern, click the [Send] button to write the set data to the PZ400/PZ900. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.4 Program Setting

Event selection 

Events can be enabled/disabled individually 
in each segment. 

[Send] button 

Click “Patten setting (2)” 
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8.5 Program Operation 

■ Starting Program Operation 

● Starting the program operation after completing the program 
setting 

1. Switch the screen to the Driving operation screen, and select a desired execution pattern. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Switch the operation mode to "1: Program control mode (RUN)". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.5 Program Operation 

② Select “Execution 
pattern number” 

① Select “1: Program control mode 
(RUN)” 

③ The mode is switched to the Program 
control mode (RUN), and the program 
control starts 

① Click “Driving operation” 

② Click [OK] 
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● Starting Program Operation using the Data of PZ400/PZ900 

1. Start the software in the Direct mode. 
Starting in the Direct mode will read out the data from the PZ400/PZ900 into the Setting tool. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Switch the screen to the Driving operation screen, select a desired execution pattern, and switch the mode to the 

Program control mode (RUN). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.5 Program Operation

① Click [Direct mode] 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Refer to P. 8-2 and P. 8-7 
for communication 
parameters. 

③ Monitor screen is displayed 
“Direct mode” will come up 

② Select “Execution 
pattern number” 

③ Select “1: Program control 
mode (RUN)” 

① Click “Driving operation” 

④ Click [OK] to start  
the program operation 
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● Starting the program control with the data stored in the settings file 

1. Read the settings file of PZ400/PZ900 (extension p26) stored in the PC into the setting tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make the bulk setting of the data in the settings file (extension p26) extracted in the Setting tool to the 

PZ400/PZ900. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.5 Program Operation 

① Click [File mode] 

③ Monitor screen is displayed “File mode” will come up 

① Click “Bulk setting (PC→Controller)” 

② Click [Yes] 

Continued on the next page 

② Select a file and double 
click it 
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③ Ensure that the parameters are 
properly set, then click [OK] 

Refer to P. 8-2 and P. 8-7 for communication 
parameters. 

8.5 Program Operation

Continued from the previous page 

④ Start sending data from 
the Setting tool to the 
PZ400/PZ900 

⑤ Verification results between the 
sent and the received data will 
be displayed at the completion 
of communication 

⑥ Click [×] to close the 
verification result 

TIPS 

Bulk setting of the data may take a few 
minutes to over 10 minutes. 
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3. Switch to the Direct mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Switch the screen to Driving operation screen, select a desired execution pattern, and switch the mode to the 

Program control mode (RUN). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.5 Program Operation 

① Click “Direct Mode” 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Refer to P. 8-2 and P. 8-7 for 
communication parameters. 

③ Monitor screen is displayed 
“Direct mode” will come up 

② Select “Execution 
pattern number” 

① Click “Driving 
operation” 

③ Select “1: Program control mode 
(RUN)” 

④ Click [OK] to start the 
program operation 
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■ Monitoring the Program Operation 
You can monitor the operation status on the Monitor screen.  
In case of Repeated receive, you can monitor the value that changes over time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Update Monitor screen 
The Monitor screen receives monitored values from the PZ400/PZ900 when the screen is switched. If the 
Monitor screen is left displayed, the monitored values will not be updated. To show the latest monitored 
values, read out the new monitored values from the PZ400/PZ900. 

 
Receive 

Click the [Receive] button to update the monitor values to the latest ones. 
 
 

Repeated receive 

Check the “Repeated receive” to regularly update the monitor values. 
 
 

8.5 Program Operation

Click “monitor” 

The segment under 
execution will be displayed 
in another color. 

Lamps will turn on 
according to the 
status. 

Pattern 

Time signal 
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8.6 Trend Graph (Historical Trend) 
 
The Setting tool allows the Measured value (PV), Set value (SV), Manipulated output value (MV) [Heating/Cooling] 
to be displayed in the historical trend (Trend graph). The historical trend data can be saved to the PC as a data file 
(in a CSV format). 
 

■ Setting Up Trend Graph 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
● Trend graph settings 

Sampling cycle: Set the sampling cycle of the trend graph. 
Setting range: 0.5 seconds 3 seconds 10 seconds 30 seconds 

 1 seconds 4 seconds 15 seconds 60 seconds 
 2 seconds 5 seconds 20 seconds 

Graph update cycle (sec): 
 Set the update cycle of the trend graph. 

Setting range: 1 to 60 sec. 

Number of graph display data:  
 Set the maximum number of data in graph that can be displayed in a single trend graph. 

Setting range: 10 to 5000 

Data recording folder:  The data in the trend graph can be saved to the PC as a data file (in a CSV format). 
You can designate a preferred location for the folder. Click [reference (browse)] 
button to select the folder. 

(Continued on the next page) 

8.6 Trend Graph (Historical Trend) 

Click “Trend Graph Settings” 

Click [OK] after 
setting is finished 

Click here to display 
options. 

Enter a fixed part of your choice. 
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(Continued from the previous page) 
 

Fixed part of file name: The name of the data saving file (CSV format) consists of the fixed part and the 
date/time when the trend recording was started. You can define the fixed part to your 
preference. 

 
File name (example) 

PZLOG20200925_164245.csv 
 
 
 

Automatic scale: Check “Automatic scale” to automatically set the trend graph in accordance with the 
level. When this function is unchecked, you need to manually set the maximum and 
the minimum value. 

 Checked 
 
 
 
 

 Unchecked 
 
 
 
 
 
 
 
 
 
 

8.6 Trend Graph (Historical Trend)

Record started at 16:42:45 on September 25th, 
2020 

Fixed Date Time 

Set manually 
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■ Starting/Stopping Recording the Trend Graph 
The following procedure shows how to record the program progress in the trend graph. 
(Assuming that the program setting and the trend graph setting are finished) 
 
1. Switch the mode to the Direct mode. 

The trend graph recording cannot be started unless the mode is set to the Direct mode. 
 
 
 
 
 
 
 
 
 
2. Switch the screen to the Trend graph screen.  

You can record four types of data; Set value (SV), Measured value (PV), MV1 (heat-side), and MV2 (cool-side). 
You can choose to record or not to record each of the data individually. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Nothing will be displayed when you start the Setting tool and switch the screen to the Trend graph screen 
for the first time. 

 

8.6 Trend Graph (Historical Trend) 

Click “Direct Mode” 

Click “Trend graph” 

Recording is possible by 
checking applicable items. 

TIPS 
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3. Start recording the trend graph. 

Check the check box of “Recording and graph display”, and recording the historical trend will start. 
Simultaneously with the start of recording, scales and data will be displayed on the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Start program operation. 

Switch the screen to the Driving operation screen, select a desired execution pattern, and switch the mode to 
the Program control mode (RUN). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

If you start the trend graph after you have started the program operation, recording the program operation 
from the start is not possible. 

8.6 Trend Graph (Historical Trend)

Check here 

② Select “Execution 
pattern number” 

① Click “Driving 
operation” 

TIPS 

③ Select “1: Program control mode 
(RUN)” 

④ Click [OK] to start the program 
operation 
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5. The following is a screen during the trend graph recording. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Stop the Trend graph. 

Uncheck the check box of “Recording and graph display”, and recording the historical trend will stop. 
 
 
 
 
 

 

 

You can also start/stop the Trend graph under 
“Mode” in the menu. 

 
 
 
 

8.6 Trend Graph (Historical Trend) 

Set the vertical scale to Automatic, 
then the scale will automatically 
change itself according to the 
maximum and the minimum level. 

Start program 
operation 

Lapse of time 

Start recording 

Uncheck 

TIPS 

The trend graph screen shows the 
historical trend from the start to the 
stop on a single screen. 

In accordance with the accumulation 
of data over time, the graph will be 
visually shifted to the left. 
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8.7 Data Management 
 
With the Setting tool you can save the settings of the PZ400/PZ900 to the PC or retrieve a settings file (extension 
p26) from the PC for a bulk setting. You can also verify if the settings file (extension p26) matches the set data of the 
PZ400/PZ900. 
 

■ Description of Data Management 
The details of the data management of the Setting tool may vary depending on whether you are in the Direct mode 
or in the File mode. The item in the box shown in the following figure is the executable command found under "File" 
in the menu. 
 

● In case of Direct mode 

 
 
 
 
 
 
 
 
 
 

1 Data will be received when the Direct mode is selected at the start-up, when the screen of the Setting tool has been 

switched, or when the data is sent. 
2 Data will be sent when the [Send] button in the Setting tool is clicked. 

 
 
 

● In case of File mode 

 
 
 
 
 
 
 
 
 
 
 

3 File will be read when the File mode is selected at the start-up or when the mode is switched from the Direct mode to 

the File mode, in addition to the “Read file” command. 

 

8.7 Data Management

PZ400/PZ900 
(Controller) 

Save setting to file 
(controller→file) Receive 1 

Send 2 

Data from controller 

PZ400/PZ900 
(Controller) 

Data read from the PC 

Read file 3 
(file→PC) 

Save it as a file 
with a name 
(PC→file) 

Bulk setting 
(PC→Controller) 

Setting tool Settings file 
(Extension p26) 

Refer to P. 8-28 

Refer to P. 8-31 

Refer to P. 8-33 Refer to P. 8-30 

Settings file 
(Extension p26) 

Checking set 
values 

(controller ↔ PC) 

Refer to P. 8-35 

Setting tool  
(PC) 
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■ Saving Set Data of PZ400/PZ900 to the PC 
 
 
 
 
 
 
 
 
 

* Data will be received when the Direct mode is selected at the start-up, when the screen of the Setting tool has been 

switched, or when the data is sent. 

 
1. Switch the mode from the File mode to the Direct mode. Or you can select the Direct mode at the start. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click “File” → “Save setting to file (controller → file)” in the menu. 
 
 
 
 
 
 
 
 
 
 
 
 

② Ensure that the parameters 
are properly set, then click 
[OK] 

Refer to P. 8-2 and P. 8-7 for
communication parameters. 

① Click [Direct mode] ① Click “Direct Mode” 

8.7 Data Management 

PZ400/PZ900 
(Controller) 

Save setting to file 
(controller→file) 

Receive * 

Data from Controller 

Setting tool Settings file 
(Extension p26) 

① Click “Save setting to file (controller → file)” 

Direct mode 

② Click [Yes] 

TIPS 

Reception of the data may take 
a few minutes. 
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3. The screen of “Backup (file save)” appears and the PC starts receiving the data of the PZ400/PZ900.  

The screen of “Save As” will be displayed. Save the data with a desired file name to a desired folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the saving of the settings file (extension p26). 
 
 

8.7 Data Management

① Enter the file name 

② Click [Save] 
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■ Reading the Data of the Settings File into the Setting 

Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Click “File” → “Read file (file→PC)” in the menu.  

The screen of “Open” will be displayed. Select a file and double click it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes reading the setting tool of the settings file (extension p26). 
 

8.7 Data Management 

Read the data of the settings file stored in the PC 
into the Setting tool. 

Read file 
(file→PC) 

Direct mode * 
File mode 

Settings file 
(Extension p26) 

* When "Read file" is executed in the Direct
mode, the mode will be automatically switched
to the File mode. 

[Direct mode] [File mode] 

① Click “Read file (file → PC)” ① Click “Read file (file → PC)” 

Screen after reading a file 

Setting tool  
(PC) 

② Select a file and double click it 
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■ Saving the Data of the Setting Tool to the PC 
This function is used to modify and save the data read from the data of the settings file stored in the PC (extension 
p26). 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PZ400/PZ900 (extension 

p26) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 
Select a file and double click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make necessary setting changes of the data. 
 

8.7 Data Management

Save the setting data of the Setting tool 
to the PC 

Save it as a file with a 
name (PC→file) 

File mode 

① Click [File mode] ① Click “File Mode” 

Screen after reading a file 

Setting tool  
(PC) 

Settings file 
(Extension p26) 

② Select a file and double click it 
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3. Click “File” → “Save it as a file with a name (PC → file)” in the menu. 

The screen of “Save As” will be displayed. Save the file to any desired folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the saving of the settings file (extension p26). 
 
 
 

8.7 Data Management 

① Click “Save it as a file with a name 
(PC → file)” 

② Enter the file name 

③ Click [Save] 
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■ Writing the Data of the Setting Tool to the 
PZ400/PZ900 in a Batch 

 
 
 
 
 
 
 
 
 
 
 
1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PZ400/PZ900 (extension 

p26) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 
Select a file and double click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make the bulk setting of the data in the settings file (extension p26) extracted in the Setting tool to the 

PZ400/PZ900. 
 
 
 
 
 
 
 
 
 
 

8.7 Data Management

Write the data of the setting tool to 
the PZ400/PZ900 in a batch 

Bulk setting 
(PC→Controller) 

File mode 

Screen after reading data 

Setting tool  
(PC) PZ400/PZ900 

(Controller) 

① Click [File mode] 
① Click “File Mode” 

① Click “Bulk setting (PC → Controller)” 

Continued on the next page 

② Select a file and double click it 
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This completes the bulk setting of the settings file (extension P26). 

8.7 Data Management 

③ Ensure that the parameters are 
properly set, then click [OK] 

Refer to P. 8-2 and P. 8-7 for 
communication parameters. 

Continued from the previous page 

④ The data will be started to 
be sent to the PZ400/PZ900 
from the Setting tool 

⑤ Verification results between the sent 
and the received data will be 
displayed at the completion of 
communication 

⑥ Click [×] to close the 
verification results 

TIPS 
Bulk setting of the data may take a few
minutes to over 10 minutes. 

② Click [Yes] 
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■ Verifying if the Data of the Setting Tool Matches the 
Data of the PZ400/PZ900 

 
 
 
 
 
 
 
 
 
 
 
1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PZ400/PZ900 (extension 

p26) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 

Select a file and double click it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.7 Data Management

Verify the data of the Setting tool 
and the data of the PZ400/PZ900 

Checking set values 
(ControllerPC) 

File mode 

Screen after reading data 

Setting tool  
(PC) PZ400/PZ900 

(Controller) 

① Click [File mode] ① Click “File Mode” 

② Select the file to compare and 
double click it 
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2. Click “File” → “Checking set value (controller PC)” in the menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.7 Data Management 

① Click “Checking set value 

(controller PC)” 

③ Ensure that the parameters are 
properly set , then click [OK] 

Refer to P. 8-2 and P. 8-7 for communication 
parameters. 

④ Display verification result 

TIPS 

The verification result cannot be saved. If
necessary, copy the text data and save it in
a proper manner. 

Click [×] to close the verification 
result. 

TIPS 

Verification of the data may take a few minutes. 

② Click [Yes] 
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9.1 Preparation 

■ Starting Setting Tool for the PF900 Series 
Start the Setting Tool for PF900 series in the following procedure. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Direct mode: Choose this mode to monitor or modify the data of the PF900/PF901 connected to the 
network. Connect the PF900/PF901 to the PC, then click the [Direct Mode] button. 

■ If You Have Chosen the Direct mode → Refer to P. 9-2 

File mode: Choose this mode to open the settings file (extension p27) of the PF900/PF901 stored in the 
PC. This mode is for maintenance and is used to view the setting data or make a batch 
setting for recovery and copy. 

■ If You Have Chosen the File mode → Refer to P. 9-3 

 
 

① Click [Setting Tool for  
PF900 series] 

② Choose a mode 

TIPS 

You can choose a language from 
the following: 
“Japanese (1041)” 
“English (1033)” 
“Simplified Chinese (2052)” 

9. Getting Started With Setting Tool for PF900 Series
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■ If You Have Chosen the Direct Mode 
Ensure that the PF900/PF901 is connected to the PC, then operate as follows. In this example, loader 
communication is used. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.1 Preparation 

① Click [Direct mode] 

② Configure the communication port * 

* Configure the communication port according to 
the PC you use. If you are not certain about the 
communication port number, click [See Device 
Manager]    , then the “Device Manager” will be 
shown where you can check the port number. 

A 

A 

④ Click [OK] 

③ Check “Use 
loader port” 

If you check “Use loader port”, the
communication environment will be
preset for the loader communication.
You don't have to set it by yourself. 

TIPS 

⑤ Monitor screen is displayed “Direct mode” will come up 
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■ If You Have Chosen the File Mode 
You can read the settings file of the PF900/PF901 (extension p27) stored in the PC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.1 Preparation

① Click [File mode] 

③ Monitor screen is displayed 
“File mode” will come up 

② Select a file and double click it 
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9.2 Screen Components and Menu Structure 

■ Screen Components and Functions 
Components common to each screen are explained. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu bar: Used to start functions of the Setting tool. 

For more details, refer to ■ Menu Structure (P. 9-6) 

Window for switching screens: 
Screens in the window can be switched. Click the name of screen in the tree view 
window to switch screens. 

Mode status monitor: Displays the mode status. 
File mode:  Displayed in the File mode. 
Direct mode:  Displayed in the Direct mode. 
RESET:  Lights during the Reset (RESET) mode. 
RUN:  Lights during the Program control (RUN) mode 
FIX:  Lights during the Fixed setpoint control (FIX) mode. 
MAN:  Lights during the Manual control (MAN) mode. 

Screen switch tab: Clicking the tab will switch the screen. 

Data display area: Displays various data. 

[Send] button: Writes data set with the setting tool to the PF900/PF901. This button is displayed in the 
Direct mode. 
(This button is not displayed on the Monitor screen and Operation screen.) 
 

(Continued on the next page) 

9.2 Screen Components and Menu Structure 

Menu bar 

Window for
switching 
screens 

Mode status
monitor 

Screen 
switch tab 

Data 
display area

[Send] button [Receive] button 
“Repeat” check box 
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(Screen components continues) 
 

[Receive] button Used to read monitor and setting data of the PF900/PF901 to the Setting tool. This 
button is displayed in the Direct mode. 

Data is read out from the PF900/PF901 when the Setting tool is started, the data is 
sent, or the screen is switched. If the screen is left as it is, the data will not be read out 
and the screen will not be updated. To display the latest monitored and set data, click 
[Receive] button to read out the data. 

“Repeat” checkbox: The monitor data of the PF900/PF901 is automatically read out to the Setting tool at 
regular intervals (every few seconds). 

To read out the data at the regular intervals, check “Repeat”. This item is displayed on 
the Monitor and Operation screens. 

 

9.2 Screen Components and Menu Structure
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■ Menu Structure 
This page explains the commands launched from the menu on the menu bar. 
 
 
 
 
 

● Files 
Direct mode File mode 

 
 
 
 
 
 
 
 

Save settings to a file (Controller→File) [Direct mode]: 
The setting data is read out from the PF900/PF901 and saved to the PC as a settings file 
(extension p27). 

Refer to ■ Saving Set Data of the PF900/PF901 to the PC (P. 9-29) 

Read file (File→PC) [Direct mode and File mode]: 
Read out the setting data stored in the PC (extension p27) into the Setting tool and switch the 
mode to the File mode. 

Refer to ■ Reading the Data of the Settings File into the Setting Tool (P. 9-31) 

Save as a file with a name (PC→File) [File mode]: 
The setting data of the Setting tool is saved to the PC as a settings file (extension p27). 

Refer to ■ Saving the Data of the Setting Tool to the PC (P. 9-32) 

Batch setting (PC→Controller) [File mode]: 
The setting data of the Setting tool is written into the PF900/PF901 in batches. 

Refer to ■ Writing the Data of the Setting Tool to the PF900/PF901 in  
a Batch (P. 9-34) 

Set value comparison (ControllerPC) [File mode]: 
Verify if the setting data of the settings file (extension p27) will match the setting data of the 
PF900/PF901. 

Refer to ■ Verify if the Data of the Setting Tool Matches the Data of the  
PF900/PF901 (P. 9-37) 

 
 
 
 
 

(Continued on the next page) 

9.2 Screen Components and Menu Structure 

Menu bar 
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(Continued from the previous page) 
 

● Setting 
 
 
 
 
 

Communication settings: Used to set communication parameters. Switch to the Direct mode after the 
setting is completed. 

Comm port name: COM1 to COM256 

Refer to P. 9-2 for how to identify  

the communication port. 

Address:  0 to 99  
(Maximum connections: 31) 

Speed: 2400 bps 19200 bps 
4800 bps 38400 bps 
9600 bps 57600 bps 

Data bits: 7 bit, 8 bit 

Parity:  None, even, odd 

Stop bit:  1 bit, 1.5 bits, 2 bits 

Send delay time: 0 to 500 ms 

 
 
 
 
 
 

Trend graph settings: 
Used to set parameters required for the Trend graph display. 

Refer to ■ Setting Up Trend Graph (P. 9-23) 

Font: Used to set the character font to be displayed on the Setting tool screen. 

 
 
 
 
 
 
 
 
 
 
 

(Continued from the previous page) 

9.2 Screen Components and Menu Structure

Check “Use the loader port” for 
loader communication. 

You can check the communication port
number in the Device Manager in Windows. 

Use this option when the data cannot be obtained from the
Device Manager. 



9-8 IMT01D11-E7 

 
 
 
 

(Continued from the previous page) 
 

● Mode 

Direct mode/File mode: 

Choose a mode. 

Graph ON/Graph OFF: 
Used to set on/off the Trend graph. 

Refer to ■ Starting/Stopping Recording the Trend 
Graph (P. 9-25) 

Allow engineering mode change: 
Choose this option when changing the settings in the 
Engineering mode. 

 
 
 
 
 
 
 
 

● Help 
Version Information: Displays version information for the Setting tool. 

Item description: When you click the title of the monitor and set items, 
explanation about the item will be displayed. 

 
 
 
 
 

9.2 Screen Components and Menu Structure 

When this is checked, 

the change of the 

Engineering mode is 

possible 
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9.3 Program Setting Example 

■ Preparing a Program to be set 

We use the following program example to explain the setting procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The above program pattern consists of the following data. 
 

Execution pattern number 1         

Segment number 1 2 3 4 5 6 7 8 9 

Segment level 50 80 80 100 100 60 60 20 20 

Segment time (hour: minute) 0:30 0:20 0:40 0:20 1:00 0:30 0:40 0:30 0:20 

PID memory group number 1 1 2 3 2 1 2 1 2 

Event memory group number 1 2 3 2 3 2 3 2 3 

Wait memory group number 1 1 2 1 2 1 2 1 2 
 

Segment repeat Start number: 1 

Segment repeat End number: 2 

Number of execution of segment repeat 2 

Number of execution of pattern repeat 1 

Link pattern number 0 

Pattern end output duration (hour: minute) 0:01 

Time signal memory group number 1 
 

Setting content of Time signal memory group number 

Group number 1       

Memory number 1 2 3 4 5 6 7 

Output destination (TS) 1 1 1 2 2 2 2 

Start segment 1 2 4 3 5 7 9 

Start time (hour: minute) 0:10 0:10 0:10 0:00 0:00 0:00 0:00 

End segment 2 3 5 4 6 8 9 

End time (hour: minute) 0:05 0:05 0:05 0:00 0:00 0:00 0:20 

 
(Continued on the next page) 

Level

100

50

0 Time
Segment 1 2 3 4 5 6 7 8 9

Time signal output state

Time signal 1 (TS1)

Time signal 2 (TS2)
Memory 1 Memory 2 Memory 3

Memory 5 Memory 6 Memory 7Memory 4

9.3 Program Setting Example

Segment repeat: 1 

No pattern repeat 

No pattern link 
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Other program related parameters are set on the following screens. 
 Parameter setting…PID memory screen 

 Parameter setting…Event memory screen 
 Parameter setting…Wait memory screen 
 Setup setting screen 

 Engineering mode…Screens F71/F80 
 

For more details, refer to Instruction Manual of PF900/PF901 (IMR02L03-E□) or Users Manual  
(IMR02L04-E□). 

 
 
 
 

9.3 Program Setting Example 
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9.4 Program Setting 

■ Setting Program Related Initial Parameters 

1. Switch the mode to the Direct mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Set up to allow changes in the Engineering mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Ensure that the current mode is the Reset mode. 
 
 
 
 

 

 

If you are not in the RESET mode, switch the mode to “0: RESET mode (RESET)” in the Operation screen. 
(Continued on the next page.) 

9.4 Program Setting

① Click “Direct mode” 

Click “Allow engineering mode change” 

When this is checked, 
changes in the Engineering 
mode is possible. 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Make sure that the 
RESET lamp is lit 

TIPS 

Refer to P. 9-2 and P. 9-7 for 
Communication parameters. 
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4. Set the following program related parameters. 

 Parameter setting…PID memory screen 

 Parameter setting…Event memory screen 
 Parameter setting…Wait memory screen 
 Setup setting screen 

 Engineering mode…Screens F71/F80 
 
 
 

When you finished setting up each screen, click the [Send] button to write the set data to the PF900/PF901. 
 
 
5. Set other parameters other than the program related parameters, if necessary. 
 
 

9.4 Program Setting 

TIPS 
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■ Setting Program Pattern 
1. Switch the screen to the “Set Pattern 1” screen, and set the program pattern referring to the setting example on 

page P. 9-9.  
(Enter values in the fields surrounded by a red frame) 
When you finished setting up on each screen, click the [Send] button to write the set data to the PF900/PF901. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 
 

9.4 Program Setting

Pattern will be 
displayed according 
to the Level. 

Scroll the displayed 
segments 

< > Scroll by one segment 

<< >> Scroll by 8 segments 

You can set a pattern name 
for each pattern  

(max.11 characters) 

Pattern Graph 

Displays segment level, segment time, and time signals. 

(Refer to the next page) 

[Send] button 

Click “Set pattern 1” 
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Pattern Display: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pattern Displayed according to segment levels and segment time (Time). The number of 
displayed segments is determined by the Pattern End Segment. The Segment 
width on the graph varies according to the Segment time length. 

Maximum and minimum values of the Pattern 
Check “Auto scale”, then the values will be automatically displayed adjusted to 
the maximum and minimum values of the Segment level. 
When “Auto scale” is unchecked, you need to manually set the maximum and 
the minimum values. 

 

 

 

 

 

 

Segment repeat 
Indicated in the segment to be repeated. 

Memory Displayed according to the memory setting of time signal. Start/End segments 
and the status of start/end time can be also displayed. 

Total of Segment time 
The total Segment time (Program pattern time) is automatically displayed. 

 
 

(Continued on the next page) 

9.4 Program Setting 

Maximum and 
minimum values of 
the Pattern 

Total segment time 

Pattern 

Memory 1 

Memory 4 

Memory 2 

Memory 3 

Memory 5 

Memory 6 

Memory 7 

Segment repeat 

Manually set 

Uncheck 
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2. Switch the screen to the “Set pattern 2” screen, and set the program pattern referring to the setting example on 

page P. 9-9.  
(Enter values in the fields surrounded by a red frame) 
When you finished setting up the program pattern, click the [Send] button to write the set data to the PF900/PF901. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copy patterns: Copy the pattern currently displayed to another pattern No. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on the next page) 

9.4 Program Setting

[Send] button 

Click “Set pattern 2” 

Used to copy a 
pattern. 

(See below) 

① Click [Pattern copy] 

② Select the destination 
Pattern number 

③ Click [Execute copy] 

④ Click [OK] and then 
[Send] button 

The pattern will not be copied unless the 
[Send] button is clicked. 

Used to insert/delete 
segments. 

(Refer to the next page) 
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Insert segment: Insert a new segment into the displayed pattern. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nothing is set in the inserted segment. Ensure to make segment setting after the insertion. 
 
 

Delete segment: Delete the displayed segment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.4 Program Setting 

① Click [Insert Segment] 

② Select the segment number at 
the Insert position 

④ Click [execution] to insert 
segment(s) at the designated 
position 

③ Set the number of segments to be 
inserted 

① Click [Delete segment] 

② Select the segment number at the Delete position 

④ Click [execution] to delete  
the segment at the designated 
location 

③ Set the number of segments to be 
deleted 

TIPS 
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9.5 Program Operation 

■ Starting Program Operation 

● Starting the program operation after completing the program 

setting 

1. Switch the screen to the Operation screen, and select a desired execution pattern. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Switch the operation mode to “1: Program control mode (PROG)”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.5 Program Operation

② Select “Execution 
pattern number” 

① Select “1: Program control mode 
(PROG)” 

③ The mode is switched to the Program 
control mode, and the program 
control starts 

① Click “Operation” 

② Click [OK] 
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● Starting the program operation using the data of PF900/PF901 

1. Start the software in the Direct mode. 
Starting in the direct mode will read out the data from the PF900/PF901 into the Setting tool. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Switch the screen to the Operation screen, select a desired execution pattern, and switch the mode to the 

Program control mode (PROG). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.5 Program Operation 

① Click [Direct mode] 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Refer to P. 9-2 and P. 9-7 
for communication 
parameters. 

③ Monitor screen is displayed 
“Direct mode” will come up 

② Select “Execution 
pattern number” 

③ Select “1: Program control 
mode (PROG)” 

① Click “Operation” 

④ Click [OK] to start  
the program operation 
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● Starting the program control with the data stored in the settings file 

1. Read the settings file of PF900/PF901 (extension p27) stored in the PC into the setting tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make the batch setting of the data in the settings file (extension p27) extracted in the Setting tool to the 

PF900/PF901. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.5 Program Operation

① Click [File mode] 

③ Monitor screen is displayed “File mode” will come up 

① Click “Batch setting 
(PC→Controller)” 

③ Click [OK] 

Continued on the next page 

② Choose items to be 
set in a batch 

② Select a file and double 
click it 
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④ Ensure that the parameters are 
properly set, then click [OK]. 

Refer to P. 9-2 and P. 9-7 for communication 
parameters. 

9.5 Program Operation 

Continued from the previous page 

⑤ Start sending data from 
the Setting tool to the 
PF900/PF901 

⑥ Verification results between the 
sent and the received data will 
be displayed at the completion 
of communication 

⑦ Click [×] to close the 
verification result 

TIPS 

Batch setting of the data may take a few 
minutes to over 10 minutes. 
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3. Switch the mode to the Direct mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Switch the screen to the Operation screen, select a desired execution pattern, and switch the mode to the 

Program control mode (RUN). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.5 Program Operation

① Click “Direct mode” 

② Ensure that the 
parameters are properly 
set, then click [OK] 

Refer to P. 9-2 and P. 9-7 for 
communication parameters. 

③ Monitor screen is displayed 
“Direct mode” will come up 

② Select “Execution 
pattern number” 

① Click “Operation” 

③ Select “1: Program control mode 
(PROG)” 

④ Click [OK] to start the 
program operation 



9-22 IMT01D11-E7 

 
 
 

■ Monitoring the Program Operation 
You can monitor the operation status on the Monitor screen. 
In case of Repeated receive, you can monitor the value that changes over time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Update Monitor screen 
The Monitor screen receives monitored values from the PF900/PF901 when the screen is switched. If the 
“Monitor” screen is left displayed, the monitored values will not be updated. To show the latest monitored 
values, read out the new monitored values from the PF900/PF901. 

 
Receive 

Click the [Receive] button to update the monitor values to the latest ones. 
 
 

Repeat 

Check the “Repeate” to regularly update the monitor values. 
 
 

9.5 Program Operation 

Click “Monitor” 

The segment under 
execution will be displayed 
in another color. 

Lamps will turn on 
according to the 
status. 

Pattern 

Time signal 

Segment repeat 
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9.6 Trend Graph (Historical Trend) 
 
The Setting tool allows the Measured value (PV), Set value (SV), Manipulated output value (MV) [Heating/Cooling] 
to be displayed in the historical trend (Trend graph). The historical trend data can be saved to the PC as a data file 
(in a CSV format). 
 

■ Setting Up Trend Graph 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Trend graph settings 

Sampling cycle: Set the sampling cycle for the trend graph. 
Setting range: 0.5 seconds 3 seconds 10 seconds 30 seconds 

 1 seconds 4 seconds 15 seconds 60 seconds 
 2 seconds 5 seconds 20 seconds 

Graph update cycle (secconds) 
: Set the update cycle of the trend graph. 

Setting range: 1 to 60 sec. 

Number of graph display data: 
Set the maximum number of data in graph that can be displayed in a single trend graph. 
Setting range: 10 to 5000  

Data recording folder: The data in the trend graph can be saved to the PC as a data file (in a CSV format). 
You can designate a preferred location for the folder. Click the [Refer] button to select 
the folder. 

(Continued on the next page) 

9.6 Trend Graph (Historical Trend)

Click “Trend graph settings” 

Click [OK] after 
setting is finished 

Click here to display 
options. 

Enter a fixed part of 
your choice. 
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(continued from the previous page) 
 
Fixed part of the file name: The name of the data saving file (CSV format) consists of the fixed part and the 

date/time when the trend recording was started. You can define the fixed part to your 
preference. 

 
File name (example) 

PFLOG20200925_164245.csv 
 
 
 
Automatic scale (Left): Check “Left auto scale” to automatically set the trend graph in accordance with the 

level. When this function is unchecked, you need to manually set the maximum and 
the minimum value of the left scale. 

 
 
 
 
 
Automatic scale (Right):  Check “Right auto scale” to automatically set the trend graph in accordance with the 

Manipulated output. When this function is unchecked, you need to manually set the 
maximum and the minimum value of the right left scale. 

 
 
 
 
 
 
 

9.6 Trend Graph (Historical Trend) 

Record started at 
16:42:45 on September 25, 2020 

Fixed Date Time 

Set manually 
Unchecked 

Set manually 
Unchecked 
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■ Starting/Stopping Recording the Trend Graph 
The following procedure shows how to record the program progress in the trend graph. 
(Assuming that the program setting and the trend graph setting are finished) 
 
1. Switch the mode to the Direct mode. 

The trend graph recording cannot be started unless the mode is set to the Direct mode. 
 
 
 
 
 
 
 
 
 
2. Switch the screen to the Trend graph screen. 

You can record four types of data; Set value (SV), Measured value (PV), MV1 (heat-side), and MV2 (cool-side). 
You can choose to record or not to record each of the data individually. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Nothing will be displayed when you start the Setting tool and switch the screen to the Trend graph screen 
for the first time. 

 

9.6 Trend Graph (Historical Trend)

Click “Direct mode” 

Click “Trend graph” 

Recording is possible by 
checking applicable items. 

TIPS 
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3. Start recording the trend graph. 

Check the check box of “Data recording and graph display”, and recording the historical trend will start. 
Simultaneously with the start of recording, scales and data will be displayed on the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Start program operation. 

Switch the screen to the Operation screen, select a desired execution pattern, and switch the mode to  
the Program control mode. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

If you start the trend graph after you have started the program operation, recording the program operation 
from the start is not possible. 

9.6 Trend Graph (Historical Trend) 

Check here 

TIPS 

② Select “Execution 
pattern number” 

① Click “Operation” 

③ Select “1: Program control 
mode (PROG)” 

④ Click [OK] to start the program 
operation 
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5. The following is a screen during the trend graph recording. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Stop the Trend graph. 

Uncheck the check box of “Data recording and graph display”, and recording the historical trend will stop. 
 
 
 
 
 

 

 

You can also start/stop the Trend graph under 
"Mode" in the menu. 

 
 
 
 

9.6 Trend Graph (Historical Trend)

Set the left scale to Automatic scaling 
(Left), then the scale will automatically 
change itself according to the maximum 
and the minimum level. 

Start program 
operation 

Lapse of time 

Start recording 

Uncheck 

TIPS 

Set the right scale to Automatic scaling 
(Right), then the scale will automatically 
change itself according to the maximum 
and the minimum manipulated output. 

The trend graph screen shows the 
historical trend from the start to the 
stop on a single screen. 

In accordance with the accumulation 
of data over time, the graph will be 
visually shifted to the left. 
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9.7 Data Management 
 
With the Setting tool you can save the settings of the PF900/PF901 to the PC or retrieve a settings file (extension 
p27) from the PC for a batch setting. You can also verify if the settings file (extension p27) matches the set data of 
the PF900/PF901. 
 

■ Description of Data Management 
The details of the data management of the Setting tool may vary depending on whether you are in the Direct mode 
or in the File mode. The item in the box shown in the following figure is the executable command found under “File” 
in the menu. 
 

● In case of Direct mode 

 
 
 
 
 
 
 
 
 
 

1 Data will be received when the Direct mode is selected at the start-up, when the screen of the Setting tool has been 

switched, when the data is sent, or when the [Receive] button is clicked. 
2 Data will be sent when the [Send] button in the Setting tool is clicked. 

 
 
 

● In case of File mode 

 
 
 
 
 
 
 
 
 
 
 

3 File will be read when the File mode is selected at the start-up or when the mode is switched from the Direct mode to 

the File mode, in addition to the “Read file” command. 

 

9.7 Data Management 

Save settings to a file 
(controller→file) Receive 1 

Send 2 

Data from controller 

Data read from the PC 

Read file 3 
(File→PC) 

Save as a file with 
a name 

(PC→File) 

Batch setting 
(PC→Controller) 

Setting tool Settings file  
(extension p27) 

Refer to P. 9-29 

Refer to P. 9-32 

Refer to P. 9-34 Refer to P. 9-31 

Settings file  
(extension p27) 

Set value 
comparison  

(controllerPC) 

Refer to P. 9-37 

PF900/PF901 
(Controller) 

PF900/PF901 
(Controller) 

Setting tool  
(PC) 
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■ Saving Set Data of PF900/PF901 to the PC 
 
 
 
 
 
 
 
 
 

* Data will be received when the “Direct mode” is selected at the start-up, when the screen of the Setting tool has been 

switched, when the data is sent, or when the [Receive] button is clicked. 

 
1. Switch the mode from the File mode to the Direct mode. Or you can select the Direct mode at the start. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click “File” → “Save settings to a file (controller → file)” in the menu. 
 
 
 
 
 
 
 
 
 
 
 

② Ensure that the parameters 
are properly set, then click 
[OK] 

Refer to P. 9-2 and P. 9-7 for 
communication parameters. 

TIPS 

Data receive may take 
over five minutes. 

① Click [Direct mode] ① Click “Direct mode” 

Save settings to a file 
(controller→file) 

Receive * 

Data from Controller 

Setting tool Settings file  
(extension p27) 

① Click “Save settings to a file (controller → file)” 

Direct mode 

PF900/PF901 
(Controller) 

9.7 Data Management

② Click [Yes] 
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3. The screen of “Backup (Save File)” appears and the PC starts receiving the data of the PF900/901. 

The screen of “Save As” will be displayed. Save the data with a desired file name to a desired folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the saving of the settings file (extension p27). 
 
 

9.7 Data Management 

① Enter the file name 

② Click [Save] 
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■ Reading the Data of the Settings File into the Setting 

Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Click “File” → “Read file (File→PC)” in the menu. 

The screen of “Open” will be displayed. Select a file and double click it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the reading of the settings file (extension p27). 
 
 

9.7 Data Management

Read the data of the settings file stored in the PC 
into the Setting tool. 

Read file 
(File→PC) 

Direct mode * 
File mode 

Settings file  
(extension p27) 

* When "Read file" is executed in the Direct
mode, the mode will be automatically switched
to the File mode. 

[Direct mode] [File mode] 

① Click “Read file (File →PC)” ① Click “Read file (File →PC)” 

② Select a file and double 
click it 

Screen after reading a file 

Setting tool 
(PC) 
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■ Saving the Data of the Setting Tool to the PC 
This function is used to modify and save the data read from the data of the settings file stored in the PC (extension 
p27). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PF900/PF901 (extension 
p27) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 
Select a file and double click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make necessary setting changes of the data. 
 

9.7 Data Management 

Save the setting data of the Setting tool
to the PC 

Save as a file with a name 
(PC→File) 

File mode 

① Click [File mode] ① Click “File mode” 

② Select a file and double click it 

Screen after reading data 

Setting tool  
(PC) 

Settings file 
(Extension p27) 
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3. Click “File” → “Save as a file with a name (PC→File)” in the menu. 

The screen of “Save As” will be displayed. Save the file to any desired folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes saving the settings file (extension p27). 
 
 

9.7 Data Management

① Enter the file name 

② Click [Save] 
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■ Writing the Data of the Setting Tool to the 
PF900/PF901 in a Batch 

 
 
 
 
 
 
 
 
 
 
 

1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PF900/PF901 (extension 
p27) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 
Select a file and double click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Make the batch setting of the data in the settings file (extension p27) extracted in the Setting tool to the 

PF900/PF901. 
 
 
 
 
 
 
 
 
 
 

PF900/PF901 
(Controller) 

9.7 Data Management 

Write the data of the setting tool to 
the PF900/PF901 in a batch. 

Batch setting 
(PC→Controller) 

File mode 

Screen after reading data 

Setting tool  
(PC) 

① Click [File mode] ① Click “File mode” 

② Select a file and double click it 

① Click “Batch setting (PC → Controller)” 

Continued on the next page 
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9.7 Data Management

③ Click [OK] 

④ Ensure that the parameters are 
properly set, then click [OK] 

Refer to P. 9-2 and P. 9-7 for 
communication parameters. 

Continued from the previous page 

⑤ The data will be started to 
be sent to the PF900/PF901 
from the Setting tool 

② Select items to be set 
in batches 

Continued on the next page 

TIPS 
Batch setting of the data may take a few 
minutes to over 10 minutes. 
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This completes the batch setting of the settings file (extension p27). 

⑥ Verification results between the 
sent and the received data will be 
displayed at the completion of 
communication 

⑦ Click [×] to close the 
verification results 

Continued from the previous page

9.7 Data Management 



9-37 IMT01D11-E7

 
 
 

■ Verifying if the Data of the Setting Tool Matches the 
Data of the PF900/PF901 

 
 
 
 
 
 
 
 
 
 
 
1. Switch the mode from Direct mode to File mode. Alternatively, read the settings file of PF900/PF901 (extension 

p27) stored in the PC into the Setting tool when starting the Setting tool. The screen of “Open” will be displayed. 
Select a file and double click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.7 Data Management

Verify the data of the Setting tool 
and the data of PF900/PF901 

Set value comparison 
(controllerPC) 

File mode 

Screen after reading data 

Setting tool  
(PC) 

PF900/PF901 
(Controller) 

① Click [File mode] ① Click ”File mode” 

② Select a file to compare and 
double click it 



9-38 IMT01D11-E7 

 
 
 
 
 

2. Click “File” → ”Set value comparison (controller PC)” in the menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.7 Data Management 

① Click “Set values comparison 

(controllerPC)” 
② Click [Yes] 

③ Ensure that the parameters are 
properly set, then click [OK] 

Refer to P. 9-2 and P. 9-7 for communication
parameters. 

④ Display verification result 

TIPS 
The verification result cannot be saved. If 
necessary, copy the text data and save it in
a proper manner. 

Click [×] to close the verification 
result. 

TIPS 

Verification of the data may take a few minutes. 
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A.1 List of Supported Languages 
Languages supported by PROTEM2 depend on models and communication types. Refer to the following list for the 
supported languages. 

Languages can be switched in the main menu. (Refer to P. 4-1) 
 

● List of supported languages for PROTEM2 (English) 
[Base Tool] 

Supported languages 

Supported models 

English Japanese Simplified Chinese 

RKC 
comm. * 

Modbus 
Loader 
comm. 

RKC 
comm. * 

Modbus 
Loader 
comm. 

RKC 
comm. * 

Modbus 
Loader 
comm. 

SRZ System Z-COM-A          

 Z-TIO-A/B/C/D          

 Z-DIO-A          

 Z-CT-A          

 Z-TIO-G       ● ● ● 

 Z-TIO-G (D.P.: 3 digits)        ●  

SR Mini  

[SR Mini System/SR Mini HG System] 
      ● ● 

 

SR Mini 2 

[SR Mini System/SR Mini HG System] 

(without memory area) 

      ● ● 

 

SRJ J-TI          

B400         ●  

FB series FB100          

 FB400/900          

FZ series FZ110          

 FZ400/900          

GZ series GZ400/900          

HA series HA400/900       ● ●  

 HA430/930       ● ●  

RB series RB100/400/500/700/900          

RD series RD100/400/500/700/900          

RZ series RZ100/400          

SA series SA100/200          

SB1        ● ● ● 

AG500        ● ● ● 

PG500        ● ● ● 

NWS series NWS-COM          

 NWS-COM-M1          

PZ series PZ400/900 (for Logger)          

PF series PF900/901 (for Logger)          

IOPD           

THV-A1         ●  

THV-40/THV-10 (150/200A)         ● 

THV-10 (20~100A)       ● ● ● 

COM-KG (NWS Wireless communication)          

COM-ME series          

COM-ML series          

: Supported ●: Menu / Commands: Simplified Chinese, Data name: English * Serial communication 

 

 

 

The "Modbus/TCP" communication protocol supports COM-ML-1 and COM-ME-1. 
 

A. Appendix 

TIPS 
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[Setting tool for Program control] 

The Setting tool for the PZ series and the Setting tool for the PF900 require the language to be switched on the first 
screen (P. 8-1 or P. 9-1) as well as the language switch in the Menu screen (Refer to P. 4-1). 

Supported languages 

Supported models 

English Japanese Simplified Chinese 

RKC 
comm. * 

Modbus 
Loader 
comm. 

RKC 
comm. * 

Modbus 
Loader 
comm. 

RKC 
comm. * 

Modbus 
Loader 
comm. 

PZ series PZ400/900           

PF series PF900/901           

: Supported * Serial communication 

 

 

 

 

 

 
 
 

A.1 List of Supported Languages 
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